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PI BatchViewTM is a set of tools for viewing live and historical batch data in PI ProcessBook® 
displays, Microsoft® Excel® spreadsheets, the PI BatchView QuickSearch application, and 
other applications that support Microsoft ActiveX® controls. 

The PI BatchView components are: 

Component Description 

Batch symbols for 
PI ProcessBook 

A tool for displaying batch data in PI ProcessBook displays. You can display 
Batch Trends, a Gantt chart, a Results Table, a run-time Search, and the Batch 
Group. With these tools you can run simple and complex queries for batches, 
compare multiple batches, build trends of relevant data from these batches, 
perform cycle-time analyses, align your batch data, and refine your search in 
the sub-batches to perform detailed troubleshooting and process analysis. 

Microsoft Excel 
add-in 

A set of dialog boxes and functions that let you incorporate batch data in your 
spreadsheets. When used in conjunction with PI DataLink, you can view the 
process data from your batches. 

PI BatchView 
QuickSearch 

Allows simple or complex searches for batches without the need to set up a 
display or a spreadsheet. 

PI BatchView 
ActiveX controls 

Tools for searching and displaying batches in customized applications or Web 
pages. These controls are the foundation for the searches in all the other 
components. You can incorporate them into programs that you design for users 
who have PI BatchView installed on their computers. These include all of the 
search controls as well as the Results Table. 

With PI BatchView you can view batch information stored in the PI Server databases. 
Version 3.1 leverages the batch data in the Batch Database associated with equipment in the 
PI Module DatabaseTM in PI Server version 3.3 SR1 and greater. It still provides access to 
your existing data in the Batch Subsystem and is backward compatible with your existing PI 
ProcessBook displays and Microsoft Excel spreadsheets. 

 

What's New in this Version 

PI BatchView 3.1 introduces several new features: 

• New Microsoft Excel add-in with full support for the PI Batch Database, including 
PIBatches and PISubBatches (requires Microsoft Excel XP or later). 

• Custom naming of PI BatchTM terms. 

• Integration with PI ProcessTemplates version 1.3.0.4 and later (as limit sets). 

• Ability to create Gantt charts and Trends showing only PISubBatch data. 

Chapter 1 

Introduction 
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• Ability to show trace data outside the time range of the PIUnitBatch. 

• New column types for the Results Table. 

• The Unit Attribute of the search can now consume PI ProcessBook's Module Context. 

• Several performance improvements, including significant improvements to search speed. 

• Type Library enhancements to the Batch symbols for PI ProcessBook for the VBA 
programmer. 

 

PI Batch Terminology 

This user guide refers to various batch items generically as batches. However, there are 
specific types of batches stored on the PI Server. 

The following terms are from the Batch Database (BDB). All batches in the BDB have start 
and end time properties as well as a PI Server property. 

PIBatch: A PIBatch relates to the actual material that is produced. A PIBatch may contain 
any number of PIUnitBatches that ran in parallel or series. A PIBatch has these properties: 

• Batch ID 

• Product 

• Recipe 

A PIBatch also contains a collection of PIProperties. PIProperties are named values that may 
contain any number of data types. 

PIUnitBatch: A PIUnitBatch runs within a specific piece of equipment called a PIUnit. This 
PIUnit is a PIModule that is defined in the PI Module Database on the PI Server. In a PIUnit, 
exactly one PIUnitBatch can be running at a given time. A PIUnitBatch has these properties: 

• Batch ID 

• Product 

• ProcedureName 

• Unit 

The PIUnitBatch is the replacement for the Batch Subsystem "Batch" entity. If the Batch 
Subsystem migration steps are taken for a particular Unit in the Batch Subsystem, the Unit's 
Batches are interpreted as PIUnitBatches. 

PISubBatch: A PISubBatch must have a PIUnitBatch as an ultimate parent. PISubBatches 
can have child PISubBatches. This allows for hierarchies of batch items beneath a 
PIUnitBatch. For example, you may have distinct types of sub-batches below your 
PIUnitBatch called Operations, and the child sub-batches of Operations might be called 
Phases. The Operation and Phase designations are stored in the Heading. 

• Name: The name of the sub-batch. For example, you might call the sub-batch 
representing the heating up of a reaction "Heat". 

• Heading: This is the PIHeading optionally assigned to the sub-batch. An S88-based 
(ANSI/ISA S88: Batch Control - Part I Models and Terminology) PIHeadingSet might 
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contain the PIHeadings Operation, Phase, and Step. In this hierarchy, Operation sub-
batches are children of PIUnitBatches, Phase sub-batches are children of Operations, and 
Step sub-batches are children of Phases. 

For information on the similarities and differences between the Batch Subsystem (BSS) and 
the Batch Database (BDB), see Batch Database Support of the PI Batch Subsystem found on 
the OSIsoft® Technical Support Web site, http://techsupport.osisoft.com. 

 

Installing and Upgrading PI BatchView 

See Installing PI BatchView (page 129) for system requirements and details on installing PI 
BatchView. 

Upgrading from a previous version of PI BatchView is designed to be as seamless as 
possible. Because of the advances in storing batches on the PI Server, however, the client 
tools for viewing batch data are improved and behaviors have changed. For details, see 
Upgrading From a Previous Version (page 133). 

 

Conventions Used in this Guide 

Convention Usage Example 

Italic Placeholders The limit's name is "Copy of name" (where name is 
the limit name). 

References to other 
publications 

For details on this syntax, see the PI Server 
Applications User Guide. 

Monospace 
font 

Files, directories, and paths To verify setup, browse to the PIPC\Batch folder 
(typically at C:\Program Files\PIPC\Batch). 

Code syntax and examples PIBVBatchSearchMasks(Batch ID, 
Product, Recipe) 

Bold Interface components, 
including: 
 Menu items 
 Buttons 
 Dialog boxes and their 

elements (such as text boxes, 
areas, and pages) 

To perform a batch search, choose PI > Batch 
Search… 
To revert to the default Custom Names set, click 
Restore Default. 
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The next chapters of this manual describe how to use each of the PI BatchView tools: 

• The PI BatchView QuickSearch Utility 

• Microsoft Excel Add-In 

• PI BatchView for PI ProcessBook 

• Programming Interfaces (Search and Results Controls and Customizing the Batch Group 
Symbol in PI ProcessBook) 

For information on setting search parameters and viewing results, features common to all of 
the PI BatchView tools, see Common Features of PI BatchView Tools (page 83). 

 

Part I 

PI BatchView Client Tools 
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The PI BatchView QuickSearch utility lets you run searches quickly and easily. You can 
search for batch items without having to create a PI ProcessBook BatchGroup or a Microsoft 
Excel Batch Query. PI BatchView QuickSearch contains a full set of searching tools, a basic 
display of search results and various options. 

To start PI BatchView QuickSearch, choose from the Windows Start menu, Programs > PI 
System > PI BatchView QuickSearch. The following dialog box appears: 

 
 

Search Parameters 

In the Search Parameters area at the top of the dialog box, you specify parameters to 
constrain your search for batches. Click Search to run the search. The resulting batches 
appear in the Results Table in the bottom of the dialog box. For details, see Common 
Features of PI BatchView Tools (page 83). 

To access additional search parameters, click Edit in the Advanced Search area. For details, 
see Advanced Search (page 8). 

Chapter 2 

Use PI BatchView QuickSearch 
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Set PI Server Connections 

To add or edit a PI Server reference, click the ellipsis button  next to the Server drop-down 
list to open the PI Connection Manager dialog box. Any server you add is immediately 
available for searching. 

 

Results Table 

The Results Table shows the batches resulting from a search. For details, see Working with 
Results (page 103). 

 

Search Button 

The Search button performs a search. If any server specified in the search requires a 
username and password, a PI Server Login dialog box prompts you for your login 
information. 

The search status appears in the status bar. When the search completes, the number of items 
found appears. 

 

When PI BatchView QuickSearch opens or when the search criteria change, a triangle 
appears next to the Search button. Click Search to run the batch query and remove the 
triangle. 

 
 

Clear Button 

The Clear button clears all search parameters and returns them to their defaults. The defaults 
are those that return the maximum number of searches for the last day. The Clear button does 
not clear any result items from the Results Table. 

 

Advanced Search 

You can construct more complex queries using the Advanced Search option. For example, 
you could set up a query to find all the PIUnitBatches that have a PISubBatch named "Heat" 
in which temperature exceeded 100 degrees Celsius for more than two minutes. 
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To open the Advanced Search dialog box, click Edit… in the Advanced Search area. 

The search parameters that are common to the main search dialog box and the Advanced 
Search dialog box are kept synchronized. For example, the Unit Name field is updated in the 
in the Search Parameters if you edit it in the Advanced Search. Similarly, if you change this 
field in the Search Parameters area of the main search dialog box, this field is updated in the 
Advanced Search dialog box. 

When you make any modifications to Advanced Search parameters that are not present in the 
Search Parameters, a green dot appears in the Advanced Search area: 

 

For details on Advanced Search parameters, see Advanced Searches (page 97). 

When you define advanced search criteria, PI BatchView QuickSearch preserves the 
advanced state as much as possible. If the criteria are interpreted as not advanced, the 
advanced state is lost. For example, if the criteria defines a PIUnitBatch search with default 
criteria except for the PIBatch Recipe attribute containing a mask of RQ425*, the criteria are 
considered to be advanced. If you then change the Batch Type to PIBatches, the Recipe 
attribute mask is preserved and displayed in the Recipe attribute field. At this point the 
criteria are no longer in an advanced state because the PIUnitBatch criteria are at their default 
values. 
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QuickSearch Options Dialog Box 

In the QuickSearch Options dialog box, you can configure the columns of the Results Table, 
select a Custom Names set, and select a time zone. To open the QuickSearch Options dialog 
box, click Options in the PI BatchView QuickSearch dialog box. 

 

Use the top area of this dialog box to configure the Results Table columns. For details, see 
Configuring Results (page 110). A sample Results Table appears in the lower half of the 
dialog box. If the Results Table in the PI BatchView QuickSearch dialog box contains items 
when you open the QuickSearch Options dialog box, this sample Results Table contains the 
same items. 

If you move columns in the Results Table and later want to restore the original column order, 
click Reset Columns. 

To configure a Custom Names set for PI BatchView QuickSearch, select the desired Custom 
Names Set from a PI Server in the Custom Name Set drop-down list. To change back to the 
default Custom Names Set, click Restore Default. See Using Custom Names (page 121) for 
more details. 

You can interpret and display times according to either the PI Server time zone or the client 
time zone. If both the server and the client are in the same time zone, this is not important. 
When you are looking at data from several servers in different time zones, however, you may 
want to define the time zone to display with your data. The Time Zone Selection determines 
what time zone QuickSearch uses. The client time zone is the time zone for the local 
computer. The server time zone is the time zone for the PI Server. This setting affects both 
how the TimeFrom and TimeTo are interpreted for the search criteria and how the Results 
Table displays batch times. 
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Click OK to return to the PI BatchView QuickSearch dialog box. 
 

About Button 

Click About to start the About PI BatchView dialog box, which shows version and build 
information, a list of PI BatchView files and their versions, a copyright notice, and a link to 
the OSIsoft support Web site. Click Copy To Clipboard to copy the title, version 
information, file list, and copyright notice to the clipboard. 

If PI BatchView is a demo version, a timeout date also appears. The search functions 
correctly up to but not including the timeout day that appears. 

 

Close Button 

Click Close to shut down PI BatchView QuickSearch. When you close this application, it 
preserves the current search criteria. When you restart it, the same appearance, window size, 
and search parameters appear. The Results Table contains only those items that you 
previously anchored. 
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The PI BatchView for Microsoft Excel add-in adds support for retrieving batch data from the 
PI Server. 

Once you install PI BatchView, a new menu item, PI > Batch Search..., is available in 
Microsoft Excel. This opens the PI BatchView for Excel dialog box. 

 

You can view Batch-related functions using Microsoft Excel's Insert Function dialog box. 
For details, see Microsoft Excel Functions. 

To perform a batch search, choose PI > Batch Search… The PI BatchView for Excel dialog 
box appears. 

The batch search is similar to searching in PI ProcessBook or PI BatchView Quick Search, 
with a few differences. 

Chapter 3 

View Batches in Microsoft Excel 
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Search Page 

On the Search page, configure the batch search and click Search to run a search. For details 
on configuring search parameters, see Setting Search Parameters (page 85). 

Click OK to insert a function that displays the search results in the Microsoft Excel 
spreadsheet starting at the output cell. The columns are sized so that the current results fit the 
cells. 

To discard all changes to the search configuration, click Cancel. The search, including its 
results list if any, reverts to its previous configuration. Nothing appears in the spreadsheet. 

To clear any input in the Search page or the Advanced Search dialog box, click Clear. 

To specify more search criteria in the Advanced Search dialog box, click Edit. For details 
on configuring advanced searches, see Advanced Searches (page 97). 

 

Cell References 

Most search parameters properties accept cell references as well as a text string. When a cell 
reference is accepted, the input box looks like this: 
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Some search parameters are not specified in a text box, but are option buttons or drop-down 
lists. In these cases, to make a cell reference, click the toggle button  next to the box. 
When the toggle button is depressed, the text input box appears. 

To enter a cell reference into an input box, do one of the following: 

• Click in the box where you want to enter the cell reference, then click the cell you want 
in the spreadsheet. The reference for the cell you clicked appears in the input box. 

• Enter a cell reference directly in the box. 

• Click the cell reference button . The dialog box temporarily disappears. Click the cell 
you want to use, then click the cell select button . The reference for the cell you 
clicked appears in the input box. 

Search type definitions—PIBatches and PIUnitBatches—do not accept cell references. 
 

Settings Page 

On the Settings Page, you choose what information to display in Microsoft Excel, and how to 
display it. 
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Batch Hierarchy 

In the Batch Hierarchy area you can configure how to display the hierarchy of batches in 
Microsoft Excel. The first option is how many batch levels to retrieve. If you search for a 
PIBatch, you can retrieve just the PIBatch level, the PIBatch level and PIUnitBatch level, or 
up to three PISubBatch levels down from the PIUnitBatch. This also applies to a PIUnitBatch 
search. If you search for sub-levels, you can indent levels and use the Microsoft Excel 
grouping feature. 

There are two ways to indent PISubBatch results. Select Using separate Columns to make 
each PIBatch, PIUnitBatch, and each level of PISubBatch appear in its own column. For 
example: 

 

Select Formatting cells to make each PIBatch, PIUnitBatch, and each level of PISubBatch 
appear in the same column, indented by level. For example: 

 

The Microsoft Excel grouping feature allows you to expand a PIUnitBatch to see all of its 
PISubBatches, and expand a PISubBatch to see its PISubBatches. Using grouping without 
indentation looks like this: 

 

Click the plus and minus symbols to expand and collapse the batch hierarchy. 
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Display Batch Count 

When this box is selected, the top row displays the number of PIUnitBatches in a 
PIUnitBatch search, or the number of PIBatches in a PIBatch search. 

 

Display Column Headers 

If this box is selected, the headers for the displayed data appear. 
 

Results Orientation 

You can display results in rows or columns. If you select Columns, each column contains 
one piece of information about the batch (such as Batch ID, Start Time, End Time, and so 
on). The dialog box shows a preview of the selected result orientation next to the options. 

 

Custom Names Set 

Custom Names sets in PI ProcessBook are defined at the Batch Group level. This way, each 
Batch Group can have a different Custom Names set than another, even in the same display. 

To configure a Custom Names set for a Batch Group, select a Custom Names Set from a PI 
Server in the Custom Names Set drop-down list. To revert to the default Custom Names set, 
click Restore Default. For details, see Using Custom Names (page 121). 

Once you select a set in the Batch Definition dialog box and click OK, the Batch Group in 
the display updates. 

 

Column Configuration 

In the Column Configuration area, you can configure the columns to display as well as the 
sort order and sort direction. For details, see Configuring Results (page 110). 
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PI BatchView's tools for PI ProcessBook display historical and live batch information in PI 
ProcessBook. You can monitor running batches against completed batches, compare process 
variables across batches, and perform cycle-time analysis. 

PI BatchView for PI ProcessBook includes the Batch Search, Results Table, Gantt Chart, and 
Batch Trend symbols. These symbols exist within an invisible PI ProcessBook symbol called 
a Batch Group. 

 

The Batch Group symbol provides the infrastructure for the Batch symbols to share data and 
coordinate their behavior. All of the symbols coordinated by the Batch Group symbol show 
the same batch results. For example, they would include the same list of PIUnitBatches. A 
display can have multiple Batch Groups. 

You can select one or more of the symbols to show within each Batch Group. For example, 
you may want to see the Batch Search and Results Table symbols, or only the Batch Trend. 
Or, using aliases, you can compare the same tag in different sub-batches. 

You can link multiple Batch Trends to the Batch Group to show aliases in separate trends. 
 

Chapter 4 

View Batches in PI ProcessBook 
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Batch Group Architecture 

Batches resulting from a search are stored in the Batch Group symbol. These batches are 
provided to the Results Table, Gantt Chart, and Batch Trend. Whenever a new search is run 
or the results update in real time, the Batch Group's list of batches updates and the other 
symbols shown with this Batch Group also update with the new batch list. 

The following figure shows how batch information is shared among the PI BatchView 
components within a Batch Group. User interactions on one symbol can affect the 
information in another symbol. Changes to the Results Table affect the Gantt Chart and 
changes to the Gantt Chart affect the Batch Trends. 

For example, any sorting done in the Results symbol affects the order of the batches in the 
Gantt Chart. Any aligning of batches in the Gantt Chart affects the alignment of the traces in 
the Batch Trends. 

 
 

Create and Edit a Batch Group 

To create a new Batch Group symbol on a PI ProcessBook display: 

1. In a PI ProcessBook display window, click the Batch Group button , or choose Draw 
> Batch Group. 

2. Drag the pointer in the display window to produce a rectangle. Your Batch symbols will 
appear in this rectangle. 
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3. In the Batch Definition dialog box that appears, perform a search, and configure the 
layout and settings as described in Batch Definition Dialog Box (page 21). 

4. Click OK to display the Batch Group symbol in your PI ProcessBook display. 

To edit an existing display in PI ProcessBook: 

1. Click the Build mode button . 

2. Double-click one of the symbols in the Batch Group you want to edit. 

3. In the Batch Definition dialog box that appears, perform a search, and configure the 
layout and settings as described in Batch Definition Dialog Box (page 21). 

4. Click OK to update the Batch Group symbol in your PI ProcessBook display. 
 

Batch Definition Dialog Box 

The Batch Definition dialog box appears when you create or edit a Batch Group symbol. In 
this dialog box you can choose the batch data you want to view along with the aliases, tags, 
or data sets for the data associated with the batches. Also, you can choose which symbols 
appear in your display and configure those symbols using each symbol's definition dialog 
box. 
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Batch Definition Dialog Box, Main Tab 

Search Parameters 
To show batches in a PI ProcessBook display, you must first run a search for batches (a batch 
query). The Main tab presents the most commonly used search parameters for a batch search. 
This dialog box includes the Selection, Servers, Attributes, Time Range, and Duration 
components. For details on these search components, see Setting Search Parameters (page 
85). 

Changes you make to the search parameters in the Batch Definition dialog box affect the 
display. These changes are also saved with the display. 

Note: Any changes you make to the search parameters in Run mode within the PI 
ProcessBook Display are not saved with the display. To make permanent changes 
to the search parameters in the display in Run mode, you must modify the search 
parameters using the Batch Definition dialog box. 

 

Search Button 
The Search button runs a batch query based on the search parameters specified. The results 
appear in the Results Table in the middle of the dialog box. 

When you change a search parameter, a triangle appears next to the Search button indicating 
that the search parameters have changed and no longer correspond to the results in the Results 
Table. Click Search to run the Batch Query and remove the triangle. 

 
 

The Clear button clears all search parameters and returns them to their defaults. The defaults 
are those that return the maximum number of searches for the last day. The Clear button does 
not clear any result items from the Results Table. 

 

Advanced Search 
You can construct more complex queries using the Advanced Search option. For example, 
you could set up a query to find all the PIUnitBatches that have a PISubBatch named "Heat" 
in which temperature exceeded 100 degrees Celsius for more than two minutes. 

To open the Advanced Search dialog box, click Edit… in the Advanced Search area. 

The search parameters that are common to the main search dialog box and the Advanced 
Search dialog box are kept synchronized. For example, the Unit Name field is updated in the 
in the Search Parameters if you edit it in the Advanced Search. Similarly, if you change this 
field in the Search Parameters area of the main search dialog box, this field is updated in the 
Advanced Search dialog box. 

When you make any modifications to Advanced Search parameters that are not present in the 
Search Parameters, a green dot appears in the Advanced Search area: 
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For details on Advanced Search parameters, see Advanced Searches (page 97). 
 

View Search Results in the Results Table 
In the Main tab of the Batch Definition dialog box, the results from the Batch Search are 
posted in the Results Table. This Results Table behaves the same way as the Results Table in 
a PI ProcessBook display. 

For details on the Results Table, see Working with Results (page 103). 

When you click Search, PI BatchView removes all the items from the previous search, 
except anchored items, before displaying the results of the current search. To prevent a batch 
from being removed, click the item's anchor icon . For details on anchors, see Status 
Columns (page 106). 

Note: Any changes you make to the Results within the PI ProcessBook Display in Run 
mode are not saved with the display. To permanently change the Display's 
Results Table, use the Configure Results Dialog Box (page 29). 

 

Available Aliases 
The Available Aliases list provides a list of PIAliases. To plot a trace of an alias in a trend, 
drag the alias from this list and drop it in the Tags/Aliases list, double click the alias, or select 
the alias and click Add Alias. To move all the aliases in a sub-module at once, select the sub-
module and click Add Alias or drag the sub-module to the Tags/Aliases list. 

The Available Aliases list modes are: 

• Common: Lists PIAliases that are common to all of the PIUnits involved in the batches 
in the Results Table. This is the intersection set of all the PIUnits' PIAliases. 

• All: Lists all of the PIAliases in the PIUnits involved in the batches in the Results Table. 
This is the union set of all the PIUnits' PIAliases. 

If the Results Table contains PIUnitBatches, it uses each PIUnitBatch's PIUnit to find the 
PIAliases. If the Results Table contains PIBatches, then it uses the PIUnit of each 
PIUnitBatch of each PIBatch to find the PIAliases. This list updates each time the Results 
Table in the Batch Definition dialog box updates. 

PIAliases in sub-modules of the PIUnit also appear in this list. They appear as modules with 
child PIAliases. 

This list is empty when the Results Table is empty or, in the Common Aliases mode, when 
there are no common PIAliases among all the PIUnits involved in the batches. 
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Tags/Aliases 
Tags, aliases, and data sets listed here are plotted as traces in the Batch Trend symbol(s). 

The item types in this list are: 

Icon Description 

 PIAlias 

 PIPoint (tag) 

 Data set 

 
Limit set 

 Unknown 

When an alias belongs to a sub-module of a unit, it appears with the sub-modules separated 
by the pipe character (|). For example, the alias Impeller Speed in a Sensor sub-module within 
the Mixer sub-module of the unit appears as: 

Mixer\Sensors|Impeller Speed 

To add a tag to this list, enter the tag name or click Tag Search… to find the tag. 

You can add an absolute or relative reference to a tag. An absolute reference to a tag contains 
a reference to the PI Server (for example, \\myserver\sinusoid) and shows the tag's 
value for each PIUnitBatch displayed. If the tag is renamed on the server, the tag reference in 
the Batch Group automatically retrieves the same tag. A relative tag reference does not 
contain any reference to the PI Server (for example, sinusoid). In this case, the PI Server 
from each PIUnitBatch determines which tag to retrieve data from. If this tag is renamed on 
the server, you must redefine the tag reference in the Batch Group. 

To move an alias from the Available Aliases list to the Tags/Aliases list, do one of the 
following: 

• Drag the alias to the Tags/Aliases list. 

• Select the alias and click Add Alias. 

• Double-click the alias. 

To move all the aliases in a sub-module at once, do one of the following: 

• Select the sub-module and click Add Alias. 

• Drag the sub-module to the Tags/Aliases list. 

To add a data set, click  and choose ODBC…, then select from the existing data sets or 
configure a new one. Click Custom Placeholders to configure placeholders within a data set. 

To add a limit set, click  and choose Limit Set…, then select from the existing limit sets 
or configure a new one. For more details, see Limit Sets (page 53). 

To remove an item from the Tags/Aliases list,select the item to remove, then do one of the 
following: 

• Press Delete on the keyboard. 

• Click the Delete button . 
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• If it is an alias, drag it back to the Available Aliases list. 

If you have more than one Batch Trend in a Batch Group and you add another alias to the list, 
that alias is added to the first Batch Trend. You can move data sources among trends on the 
Layout tab of the Batch Definition dialog box. 

 

Batch Definition Dialog Box, Layout Tab 

The Layout tab of the Batch Definition dialog box provides options to show or hide 
symbols, and change the settings for individual symbols within the Batch Group. 

 

Layout Tab - Classic Color 
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Layout Tab - Tag/Alias 

 
 

Visible Symbols 
The check boxes indicate whether a symbol will appear within the Batch Group. You can 
view any combination of the four symbols. The Preview area reflects these settings. 

To configure the Search, Results, and Gantt symbols, click the Configure button for the 
desired symbol, or click the symbol in the Preview area. 

By default, the layout includes a Gantt chart and a single Trend. You can add, remove, 
configure, split, and merge Batch Trends in the Trends area of the dialog box. 

To change which symbols appear by default in new Batch Groups, in PI ProcessBook choose 
Tools > Preferences > PI Batch View, and make changes as desired in the dialog box. 

 

Trends 
The Trend symbol shows each Batch Trend's title, and the aliases, tags, and data sets plotted. 
The Trends area includes these buttons: 

• Add: Add a new Batch Trend to the Batch Group. Click Configure… to select the data 
to plot. 

• Delete: Delete the selected Batch Trend from the Batch Group. 

• Configure: Open the Configure Trend dialog box (page 32) for the selected Batch Trend. 
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• Split: Split the data sources of the selected Batch Trend into individual Batch Trends 
each displaying one data source. This button is available only when tags or aliases are 
selected. 

• Merge: Merge the selected Batch Trends into one Batch Trend that displays the all the 
data sources of the selected Batch Trends. This button is available only when multiple 
trends are selected. 

• Merge All: Consolidate all data sources on existing Batch Trends in the Batch Group into 
a single Batch Trend showing all the data sources. For example, if there are four trends, 
each showing a single alias, and one trend showing two data sets, clicking Merge All 
moves all four aliases and two data sets into a single trend, removing the other unused 
trends. This button is available only when multiple trends are selected. 

 

Preview 
The Preview area shows which symbols are visible and how the symbols are configured. The 
symbols positions in the preview do not precisely match their positions within the display. 
The preview does not include actual PI Server data. 

Click a symbol in the Preview to open the Configuration dialog box for that symbol. 
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Configure Search Dialog Box 
The Configure Search dialog box configures the Search symbol that appears in the display. 
To open this dialog box, click the Layout tab in the Batch Definition dialog box. Then click 
Configure next to the Search check box. 

In the Search Components on Display area, you select which portions of the search are 
visible in the display. The defaults are Batch ID, Product, and Unit Name. The attributes are 
those available in the drop-down lists on the Main tab of the Batch Definition dialog box. 

The lower area is a preview of how the Search symbol appears in the display. 
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Configure Results Dialog Box 
The Configure Results dialog box configures the Results Table of the Batch Group in the 
display. Here you define which columns appear in the Results Table and set their properties. 
Settings include which columns appear, the column order, column width, and table sorting. 

To open this dialog box, click the Layout tab in the Batch Definition dialog box, then click 
Configure next to the Results check box. 

 

For details on using this dialog box, see Configuring Results (page 110). 
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Configure Gantt Dialog Box 
The Configure Gantt dialog box configures the Gantt Chart of the Batch Group. To open 
this dialog box, click the Layout tab in the Batch Definition dialog box, then click 
Configure next to the Gantt check box. 

 
 

Title 
The Title box sets the title that appears in the upper-left corner of the Gantt Chart. 

 

Plot Element 
Set the Background, Line Style, Line Weight, and Color of elements such as gridlines and 
text of the Batch Trend.  

Click to select an element in the Plot Elements list and then use the drop-down lists to adjust 
its setting. 

 

Display 
Use the Title and Grids check boxes to show or hide the Gantt chart's title and grid lines. 
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Click Font… to set the font for all text on the Gantt chart including the Gantt bar labels. The 
font size affects the Gantt bar size and thus how many fit in one screen. 

The Scroll Bar drop-down list affects the behavior when the number of Gantt bars exceeds 
the available space. The options are: 

• Automatic: The scroll bar appears when necessary. 

• Off: The scroll bar never appears. 

• On: The scroll bar always appears. 
 

Align when Zooming 
By default, when you zoom on the Gantt Chart in relative time mode, you select like items 
from other batches and zoom to those items. If you want to align these items you can do so 
after you zoom or, when Align when Zooming is checked, the resulting items from a zoom 
align to their start times. 

This option only affects a Gantt Chart shown in relative time mode. This option is ignored in 
absolute time mode. This option also affects the behavior of the Align and Zoom dialog box. 

 

Bar Labels 
Use the Bar Labels area to display and hide bar labels, and control what information to 
display. The options are: 

Bar Label Options Notes 

PIBatch Batch ID 
Batch ID - Product 
Product 
Recipe 

  

PIUnitBatch Batch ID 
Batch ID - Product 
Batch ID - Unit Name 
Procedure 
Product 
Product - Unit Name 
Unit Name with Unit Heading 
Unit Name 

The Unit Name with Unit Heading option 
shows the PIUnit's PIHeading where the 
PIUnitBatch ran. 

PISubBatch Name 
Name - PIUnitBatch Batch ID 
Name - PIUnitBatch Product 
Name - PIUnitBatch Unit Name 
Name with Heading 

The Name with Heading option shows the 
PISubBatch's PI Heading. 

Use the Trim options to shorten a label if it does not fit in the bars displayed. You can trim 
the label's end (abcd…), middle (abc…xyz) or beginning (…wxyz). 

 

Preview 
The Gantt chart in the Preview area shows an approximated preview based on the dialog box 
settings. 

There is no marker visible on th Gantt bar for the Tag/Alias color scheme. 
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Configure Trend Dialog Box 
You configure each Batch Trend in the Batch Group independently using the Configure 
Trend dialog box. This dialog box has a Trend tab and a Format tab. 

To open this dialog box, click the Layout tab in the Batch Definition dialog box. Then select 
the trend you want to configure and click Configure in the Trends area. 

 

Trend Tab 

 
 

TITLE 

The Title box sets the title that appears in the upper-left corner of the Batch Trend. 
 

AVAILABLE ALIASES 

The Available Aliases list provides a list of PIAliases. To plot a trace of an alias in a trend, 
drag the alias from this list and drop it in the Tags/Aliases list, double click the alias, or select 
the alias and click Add Alias. To move all the aliases in a sub-module at once, select the sub-
module and click Add Alias or drag the sub-module to the Tags/Aliases list. 

The Available Aliases list modes are: 

• Common: Lists PIAliases that are common to all of the PIUnits involved in the batches 
in the Results Table. This is the intersection set of all the PIUnits' PIAliases. 

• All: Lists all of the PIAliases in the PIUnits involved in the batches in the Results Table. 
This is the union set of all the PIUnits' PIAliases. 
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If the Results Table contains PIUnitBatches, it uses each PIUnitBatch's PIUnit to find the 
PIAliases. If the Results Table contains PIBatches, then it uses the PIUnit of each 
PIUnitBatch of each PIBatch to find the PIAliases. This list updates each time the Results 
Table in the Batch Definition dialog box updates. 

PIAliases in sub-modules of the PIUnit also appear in this list. They appear as modules with 
child PIAliases. 

This list is empty when the Results Table is empty or, in the Common Aliases mode, when 
there are no common PIAliases among all the PIUnits involved in the batches. 

 

TAGS/ALIASES 

Tags, aliases, and data sets listed here are plotted as traces in the Batch Trend symbol(s). 

The item types in this list are: 

Icon Description 

 PIAlias 

 PIPoint (tag) 

 Data set 

 
Limit set 

 Unknown 

When an alias belongs to a sub-module of a unit, it appears with the sub-modules separated 
by the pipe character (|). For example, the alias Impeller Speed in a Sensor sub-module within 
the Mixer sub-module of the unit appears as: 

Mixer\Sensors|Impeller Speed 

To add a tag to this list, enter the tag name or click Tag Search… to find the tag. 

You can add an absolute or relative reference to a tag. An absolute reference to a tag contains 
a reference to the PI Server (for example, \\myserver\sinusoid) and shows the tag's 
value for each PIUnitBatch displayed. If the tag is renamed on the server, the tag reference in 
the Batch Group automatically retrieves the same tag. A relative tag reference does not 
contain any reference to the PI Server (for example, sinusoid). In this case, the PI Server 
from each PIUnitBatch determines which tag to retrieve data from. If this tag is renamed on 
the server, you must redefine the tag reference in the Batch Group. 

To move an alias from the Available Aliases list to the Tags/Aliases list, do one of the 
following: 

• Drag the alias to the Tags/Aliases list. 

• Select the alias and click Add Alias. 

• Double-click the alias. 

To move all the aliases in a sub-module at once, do one of the following: 

• Select the sub-module and click Add Alias. 

• Drag the sub-module to the Tags/Aliases list. 
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To add a data set, click  and choose ODBC…, then select from the existing data sets or 
configure a new one. Click Custom Placeholders to configure placeholders within a data set. 

To add a limit set, click  and choose Limit Set…, then select from the existing limit sets 
or configure a new one. For more details, see Limit Sets (page 53). 

To remove an item from the Tags/Aliases list,select the item to remove, then do one of the 
following: 

• Press Delete on the keyboard. 

• Click the Delete button . 

• If it is an alias, drag it back to the Available Aliases list. 

If you have more than one Batch Trend in a Batch Group and you add another alias to the list, 
that alias is added to the first Batch Trend. You can move data sources among trends on the 
Layout tab of the Batch Definition dialog box. 

 

SCALE 

The Scale area of this dialog box is nearly identical to the Scale area of PI ProcessBook's 
Define Trend dialog box. The only difference is that the Batch Trend has a by Tag/Alias 
check box. 

You can set the Batch Trend's vertical axis to Single Scale or Multiple Scale. Single Scale 
sets the scale of the vertical axis to accommodate all of the data into one scale. The Multiple 
Scale's behavior setting depends on whether by Tag/Alias is checked: 

• When by Tag/Alias is checked (the default), each tag, alias, or data set in the Batch 
Trend has a separate scale. For example, if two batches are retrieved and two aliases are 
plotted on this trend, there are two vertical scales, one for each alias. 

• When by Tag/Alias is not checked, each trace in the Batch Trend has a separate scale. 
For example, if two batches are retrieved and two aliases are plotted on this trend, there 
are four vertical scales, one for each trace appearing on the trend. 

Scales can be either linear or logarithmic. In Single Scale mode, the setting applies to all data 
in the trend. In Multiple Scale mode, you can individually choose whether each scale is 
linear or logarithmic. The logarithmic setting is not available for digital tags. 

Note: If you select Multiple Scales, you can use logarithmic and non-logarithmic scales 
for traces in the same trend. In this case, the minor gridlines associated with a 
logarithmic plot may confuse the plot. To turn off the minor gridlines: in the 
Configure Trend dialog box click the Format Tab, then in the Plot Element area 
choose Vert. minor Grid. 

Use the Max and Min boxes to specify minimum and maximum vertical values for the plot. 
If Max is less than Min, the vertical scale flips, counting from top to bottom. You can either 
choose these from a list or enter the value manually. The settings are: 
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Setting Min Max 

Autorange 
(default 
setting) 

The trend appears with the vertical 
scale starting at the closest available 
major axis. If the minimum is 
Autorange and the maximum is not, 
the scale starts at the lowest data 
value in the trace (not on a major axis) 
and ends on the closest major axis. 

The trend appears with the vertical scale 
ending at the closest available major 
axis. If the maximum is Autorange and 
the minimum is not, the plot starts on the 
minimum value and ends on the largest 
trace value (neither min nor max are on 
a major axis). 

Database The tag's Zero attribute specifies the 
minimum plot value. If the Zero value 
is less than or equal to 0, the minimum 
is re-interpreted as Autorange. 

The tag's Zero + Span attributes specify 
the maximum plot value. If the Zero + 
Span is less than or equal to 0, the 
maximum is replaced with Autorange. 

Manual entry The value you enter sets the first value 
on the vertical axis. Values less than 
or equal to 0 are not accepted. 

The value you enter sets the vertical 
scale maximum. Values less than or 
equal to 0 are not accepted. 

The Format setting specifies how the vertical scale appears. You can choose a setting from 
the drop-down list or manually enter settings. Formatting options are: 

Format Example output for the value -1502.637 

#,##0 -1503 

#,##0.00 -1,502.64 

(#,##0) (1,503) 

(#,##0.00) (1,502.64) 

0 -1503 

0% -150264% 

0.00 -1502.64 

0.00% -150263.70% 

  

Format Description 

Database Reads the tag's digits attribute and displays the vertical axis values in standard 
format. If the length of the number exceeds the digits value, scientific notation is 
used. 

General The number appears with standard formatting, except for numbers with more than 
15 digits. In this case, scientific notation is used. The program logic uses 1.0e+15 
and 1.0e-15 as the maximum and minimum for standard formatting. 

Scientific Scientific notation is used for all values. There is no change to the scientific format 
used for trends. It appears in the format: 0.00E+00. 

Manual entry You can manually enter a value format, such as 0.0000% 
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Format Tab for Batch Color Schemes 
The appearance of this tab depends on whether you select a Batch color scheme (page 46) or 
the Tag/Alias color scheme (page 48). 

This is the Format tab for a batch color scheme. 

 
 

TRACE STYLE FOR BATCH COLOR SCHEMES 

Set Line Style and Line Weight for the trace of each of the aliases, tags, and data sets on the 
Batch Trend. 

The solid line style can use heavier line weights. Dashed lines have the standard line weight 
only. 

The trace appears in the color of the text in the preview, but it is the color of the batch on the 
display. 

The Batch color schemes typically have different line styles for each alias. The Tag/Alias 
color scheme typically has solid line styles and different colors for each alias. The pen line 
style and line weight do not change when you switch between the color schemes on the 
Settings tab. You must use this Trace Style setting to select a different pen style and weight. 

 

PLOT ELEMENT 

Set the Background, Line Style, Line Weight, and Color of elements such as gridlines and 
text of the Batch Trend.  
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Click to select an element in the Plot Elements list and then use the drop-down lists to adjust 
its setting. 

 

DISPLAY 

Select which elements to display on the Batch Trend. 

You can show or hide the Title, Grids, and Markers. When Markers is checked, each value 
that is plotted in the trend has a marker. When Markers is not checked, three markers are 
placed on the trend. 

Vertical Scale Inside Axis determines whether the numbers for the vertical axis scale are 
inside or outside the vertical axis. 

Click Font to set the font for the Batch Trend. This font setting applies to all text on the 
Batch Trend. 

 

BATCH LEGEND 

Set the attributes to display for each PIUnitBatch in the Batch Trend. The available attributes 
are: Batch ID, Unit, Product, Start Time, End Time, and Duration. The Batch Legend 
appears at the bottom of the Batch Trend.  

The Batch Legend information does not appear by default. You must select the elements that 
you want to display.  

You can see the same information that is in the batch legend in a more interactive way in the 
Results Table (page 103). 

This Batch legend lists the Tag/Alias names, in the color assigned to the batch. 
 

TRACE LEGEND - BATCH COLOR SCHEMES 

The Trace Legend displays information about each trace in the Batch Trend. The options are: 

• Tag Name: When checked, the name of the alias, tag, or data set appears as specified in 
the Tags/Aliases (page 24) list. The trace's line style appears next to the Tag Name on the 
Trace Legend. 

• Value: When checked, the values of all the running batches for each tag, alias and data 
set appear in the legend. The value shown is for the current time. 

• Eng. Units: When checked, the engineering units—which come from the tag attribute 
EngUnits defined on the PI Server—appear for each tag and alias. 

• Batch ID: When checked, the Batch ID appears for the running batches only. 

• Legend on Bottom: When checked, the Trace Legend appears below the trend area. 
When unchecked, the Trace Legend appears in the upper right corner of the Batch Trend. 

If Value, Eng. Units, or Batch ID is checked, then Tag Name is automatically checked. 

The trace legend layout depends on the color scheme (page 46) you select.  

The trace legend for the Batch Trend of a batch color scheme (page 46) shows the Tag/Alias 
name and the trace line style in the text color.  
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The trace legend of a Batch Trend of a batch color scheme (page 46) shows running 
PIUnitBatch records only. 

This example shows the trace legend layout used for all batch color schemes. 

 
 

PREVIEW 

The preview pane shows how your formatting settings will appear on the Batch Trend. 
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Format Tab for the Tag/Alias Color Scheme 
The appearance of this tab depends on whether you select a Batch color scheme (page 46) or 
the Tag/Alias color scheme (page 48). 

This is a Format tab for a Tag/Alias color scheme. 

 
 

TRACE STYLE FOR THE TAG/ALIAS COLOR SCHEME 

Set Line Style, Line Weight, Color, and Marker for the trace of each of the aliases, tags, 
and data sets on the Batch Trend. 

The solid line style can use heavier line weights. Dashed lines have the standard line weight 
only. 

Only pens that have an assigned Tag/Alias appear in the preview.   

The Batch color schemes typically have different line styles for each alias. The Tag/Alias 
color scheme typically has solid line styles and different colors for each alias. The pen line 
style and line weight do not change when you switch between the color schemes on the 
Settings tab. You must use this Trace Style setting to select a different pen style and weight. 

 

PLOT ELEMENT 

Set the Background, Line Style, Line Weight, and Color of elements such as gridlines and 
text of the Batch Trend.  

Click to select an element in the Plot Elements list and then use the drop-down lists to adjust 
its setting. 
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DISPLAY 

Select which elements to display on the Batch Trend. 

You can show or hide the Title, Grids, and Markers. When Markers is checked, each value 
that is plotted in the trend has a marker. When Markers is not checked, three markers are 
placed on the trend. 

Vertical Scale Inside Axis determines whether the numbers for the vertical axis scale are 
inside or outside the vertical axis. 

Click Font to set the font for the Batch Trend. This font setting applies to all text on the 
Batch Trend. 

 

BATCH LEGEND 

Set the attributes to display for each PIUnitBatch in the Batch Trend. The available attributes 
are: Batch ID, Unit, Product, Start Time, End Time, and Duration. The Batch Legend 
appears at the bottom of the Batch Trend.  

The Batch Legend information does not appear by default. You must select the elements that 
you want to display.  

You can see the same information that is in the batch legend in a more interactive way in the 
Results Table (page 103). 

This Batch legend lists the Tag/Alias names, in the color assigned to the batch. 
 

TRACE LEGEND FOR THE TAG/ALIAS COLOR SCHEME 

The Trace Legend displays information about each trace in the Batch Trend. The options are: 

• Tag Name: When checked, the name of the alias, tag, or data set appears as specified in 
the Tags/Aliases (page 24) list. The trace's line style appears next to the Tag Name on the 
Trace Legend. 

• Value: When checked, the values for each tag, alias and data set appear in the legend. 
The value shown is for the batch end time or the current time. 

• Eng. Units: When checked, the engineering units—which come from the tag attribute 
EngUnits defined on the PI Server—appear for each tag and alias. 

• Batch ID: When checked, the Batch ID appears for all batches. 

• Legend on Bottom: When checked, the Trace Legend appears below the trend area. 
When unchecked, the Trace Legend appears in the upper right corner of the Batch Trend. 

If Value, Eng. Units, or Batch ID is checked, then Tag Name is automatically checked. 

The trace legend layout depends on the color scheme (page 46) you select.  

The trace legend for the Batch Trend of a Tag/Alias color scheme (page 48) has the format 
Marker, BatchID, Tag Name, Value, Engineering Units. 

The following example shows the trace legend layout used for the Tag/Alias scheme.  
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PREVIEW 

The preview pane shows how your formatting settings will appear on the Batch Trend. 
 

Batch Definition Dialog Box, Settings Tab 

From the Settings tab of the Batch Definition dialog box you can set time, color, and other 
options that affect the Batch Group. 

 

Plot Time 
Plot Time affects the data displayed on the Gantt Chart and the Batch Trend. The Results 
Table, however, is unaffected by this setting and shows all batch items that the search 
retrieves. 

Note: Batch Trends created with BatchView 2.1 and configured to work with phases and 
steps must be reconfigured to use the current PISubBatch persistence model. 

The following sections describe the Plot Time options. 
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Relative - Start and End Time 
In this mode, you select relative time for plotting the batch data in the Batch Group. In 
relative time mode, the batches in the Gantt Chart and Batch Trend are aligned based on their 
start times. This is the default time mode. 

 

In relative time mode, you can plot from the Batch Start or Batch End time plus an offset, to 
the Batch Start or Batch End time plus an offset. For example, to see batch data from 10 
minutes after the batch start to the batch end, select Batch Start under Start and add an offset 
of +10 minutes, and select Batch End under End. 
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Relative - Align and Zoom 
In this mode, you can align to the start of a batch item other than the parent batch item's start 
time, as well as zoom into the batch hierarchy to view, such as just one PISubBatch. You can 
set the align and zoom settings in the same way as you would align and zoom on a Gantt 
Chart at run time. 

When you choose Relative - Align and Zoom, you use a Gantt chart to select alignment and 
zoom for the Batch Group. You must first run a batch search on the Main tab to view batches 
in the Gantt chart. 

In the following example, the Align to and Zoom to labels indicate the current settings. 

 

The Align to and Zoom to fields show a string indicating the path from the top level batch 
item returned in the batch search to the Aligned item and the items you have zoomed to. If 
available, the item heading appears. To change these settings in the Align and Zoom dialog 
box, click Configure… 

If there is more than one item of the same name at the level in the batch hierarchy, the 
instance of the item appears as a number in parenthesis. In the previous figure, the alignment 
is to a React1 PISubBatch that is a React PISubBatch's child, which is in turn the 
PIUnitBatch's child. The Zoom setting shows a Zoom to the React PISubBatch. When you 
zoom to more than one Gantt bar, a list of the batch items you zoomed to appears, separated 
by semicolons. When you zoom to an item that has other items on the same level (siblings) 
with the same name, the instance of that item is indicated in parentheses. For example, if two 
React1 PiSubBatches are below the React PISubBatches and you zoom or align to the 
second one, the path appears as PIUnitBatch\React\React1(2). Whereas if you zoom or 
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align to the first, the path appears as PIUnitBatch\React\React1. If a PIBatch is at the top 
level, the PIUnitBatch level appears by the name of the PIUnit. 

ALIGN AND ZOOM DIALOG BOX 

You can use this Gantt Chart just as you would the Gantt Chart within the display to choose 
your alignment and zoom options. To align, right-click the Gantt bar of the batch item you 
want to align to and choose the Align menu item. To zoom, drag your pointer around the 
batch items you want to zoom to. This Gantt chart obeys the preference for Align when 
zooming in the Preferences dialog box. Click Revert to reset the Gantt chart to the saved 
view. See Gantt Chart (page 63) for more information. 

In following example, a PIUnitBatch search is zoomed and aligned to a first-level 
PISubBatch named React. 

 

On the Align and Zoom dialog box, the right-click menu on the Gantt chart is the same as 
that at run time. However, the Batch Search functionality is disabled here. 

When you view this Batch Group within the display, you can choose Show Parent Level 
from the right-click menu to view the level above the current view, up to the level of the 
search (PIBatches or PIUnitBatches). 

Note: When zooming on a Gantt chart where the search is for PIBatches, the zoom must 
be a unique PIUnit. Therefore the string displayed includes the name of that 
PIUnit. For example, PIBatch\Reactor1\Heating\Heat 1 where the PIUnit name 
is Reactor1. 
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Absolute 
In Absolute time mode, you can plot from the earliest batch start time or latest batch end time 
to the latest batch end time or earliest batch start time. In this mode, the batches in the Gantt 
Chart and Batch Trend appear at the actual times they occurred. You can also offset both of 
the plotted start and end times. For example, to see data from 1 hour after the earliest batch 
start to 2 hours after the earliest batch start, choose earliest batch start time with an offset of 
+1h for the Start time and earliest batch start time with an offset of +2h for the End time. 

 
 

Plot Labels and Time Units 
The Plot Label and Time Unit boxes apply to all time modes, with the exceptions noted 
below. The Plot Label box specifies how the Gantt Chart and Batch Trend's time axes are 
labeled. The options are: 

• Actual Time: Full Time Stamp: Shows the actual time of the batch. The full date and 
time is displayed for the start and end of the Gantt chart and Batch Trend. 

• Actual Time: Partial Time Stamp: Shows the actual time of the batch. Only the hours, 
minutes and seconds are shown. The full timestamp for the end of the plot appears in the 
upper-right-hand corner of the Gantt chart and the Batch Trend. This is the default option 
for Absolute time mode. 

• Time into Batch: Displays the time since the beginning of the batch. The start of each 
batch has a time of zero. This is the default option for Relative time mode. This option is 
not available in Absolute time mode. 
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• Time into Plot: The left-hand side of the plot is set to zero and time increases to the 
right. This is useful if you use an offset or are not concerned about the actual start of the 
batch. For example, after zooming in on the Gantt Chart or Batch Trend the time is zero. 
This option is not available in Absolute time mode. 

When you use relative time mode and choose to show the actual time (either full or partial), 
consider the following circumstances: 

• If there is one running batch, this batch sets the start time of the plots. The plot's end 
time is calculated by adding the duration of the longest batch shown to the plot's start 
time. 

• If there are two or more running batches, the running batch with the earliest start time 
controls the start time of the plots. The plot's end time is calculated by adding the 
duration of the longest batch shown to the plot's start time. 

• If there are no running batches, the plot time appears as the absolute time of the most 
recently completed batch, but as soon as a running batch starts, it picks up the running 
batch's time as the single running batch case. 

The Time Units drop-down list specifies the time axis units. The default setting lets the 
Batch Group choose the most appropriate time unit to show. You can also select a specific 
time unit to show. The specific time unit is shown except when the total plot time is less than 
one unit of that specific time. For example, if you choose hours and the time plotted is 4 
hours, the scale is in hours. But if you zoom into a portion of the trend that is only a few 
minutes long, the trend chooses minutes. To use fixed time units that do not change as you 
zoom in, choose the options ending with fixed. For example, Hours - fixed shows hours as 
the time unit even when you zoom in on the trend down to the level of seconds. 

 

Color Schemes 
Set the color scheme, color, and marker for the Results Table, Batch Gantt chart, and Batch 
Trend to represent each Batch Group. The effect on each batch display type depends on the 
whether the color scheme is a Batch Color scheme (page 46) or the Tag/Alias color scheme 
(page 50). A batch color scheme defines a color and marker that is used for all symbols. The 
Tag/Alias color scheme defines the color and marker differently for each symbol. 

Select the color scheme on this Settings tab and refine the selections on the corresponding 
configure tabs, Configure Results (page 29), Configure Gantt (page 30), Configure Trend 
(page 32).  

 

Batch Color Schemes 
The batch color schemes are Categorized (page 46) (the default), Classic (page 47), Anchored 
Classic (page 47). 

 

CATEGORIZED COLOR SCHEME 

Each batch type has an assigned color and marker. Batch types are: 

• Anchored: Any batches that are anchored in the Results Table. Anchored batches stay in 
the Results Table during future searches, even if they do not meet the search criteria. 

• Completed: Batches that have completed and do not fall into the other categories. 
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• Recently Completed: The completed batch with the most recent end time. 

• Running: Batches that are currently in progress. If a Running batch is anchored, it 
appears in the Anchored batch color and marker. 

When a running batch completes, its color and marker change to the Recently Completed 
batch color and marker. The batch that was previously the Recently Completed changes to the 
Completed batch color and marker. 

On the Batch Trend, the traces are drawn first with completed batches on the bottom layer, 
then recently completed, then anchored batches, and finally running batches. This places 
running batches on top for the best visibility. 

Markers for the Completed batches are set by default to the smallest marker possible. 
 

CLASSIC COLOR SCHEME 

Each batch retrieved has its own color, marker, and (for the Batch Trend) line style. The first 
batch shown in the Results Table has the first color, the second batch has the second, and so 
on. The maximum is 12 configurable colors. Batches beyond the 12th batch cycle through the 
colors again. 

 

ANCHORED CLASSIC COLOR SCHEME 

The Anchored Classic color scheme is the same as Classic, except that the color of each 
Anchored batch remains constant while the colors of the other batches cycle. 
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Tag/Alias Color Scheme 
The Tag/Alias color scheme identifies a trace on a Batch Trend by color and marker. The 
default color and marker assigned for each Tag/Alias follow the same pattern as for the 
Classic color scheme. 

All of the bars on a Gantt that uses the Tag/Alias color scheme are the same color. The 
Marker list box is disabled. 

The Results Table for a Tag/Alias color scheme does not have a color or a marker. The Color 
and Marker list boxes are disabled. 

 
 

Marker Type and Color 
You can adjust the colors and markers that appear for each batch or batch type in each. 

For the Categorized color scheme, select the batch type to modify the color and marker.  

For the Classic color scheme, select the batch to modify the color and marker.  

For the Anchored Classic color scheme, select either the Anchored or the specific batch to 
change the color. 

For the Classic and Anchored Classic color schemes, there are 12 colors and markers. If 
there are more than 12 batches, the colors cycle starts over at the 13th color. 

For the Tag/Alias color scheme you can select the color for the Gantt bars. 
 



 Batch Definition Dialog Box 

  
PI BatchView User Guide  49 

 

Tag/Alias Color Scheme vs. Batch Color Schemes Example 
Batch color schemes assign a color for each batch and distinguish the aliases by line style. 
The Tag/Alias color scheme assigns colors differently for each symbol.The trend has a 
different color for each tag alias; all Gantt bars get the same color; the results table rows are 
not assigned a color. 

For example, a Batch Group is defined to query the temperature and level of 2 PIUnitBatches. 
The BatchIDs are XYZ25 and XYZ99. Temp1 is the alias for the temperature. Level1 is 
the alias for the level.  

In the classic color scheme: 

• XYZ25 is green on the trace, Gantt, and results table.  

• XYZ99 is light blue on the trace, Gantt, and results table.  

• Temp1 is solid line.  

• Level1 is a dashed line.  

In the Tag/Alias color scheme: 

• The trace is green for Temp1 of both PIUnitBatches 

• The trace is light blue for Level1 of both PIUnitBatches 

• Both bars are a single color, blue, on the Gantt.  

The following figures illustrate these differences.  
 

Classic Color Scheme 
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Tag/Alias Color Scheme 

 
 

Update Batch Query 
The following options determine when the display uses the Batch Query to update batch data. 

• When display updates: With each update of data on the display, the Batch Query 
parameters determine whether to add any new batches and remove any old batches from 
the batches displayed. 

• When display loads: Each time the display loads, the Batch Query updates. 

• Don't use query: The display does not use the Batch Query to retrieve batches from the 
PI Server. Only anchored batches appear. 

 

Show New Results 
This setting determines the visible state of the batches whenever new items are added to the 
batch results either when a new query is run or new items are retrieved from the server as the 
display updates. 

Icon Status Description 

 Visible New batches are set to visible when added to the results. This is the default 
setting. 

 Hidden New batches are set to hidden when added to the results. This setting is most 
useful in combination with the Results Table in the display. When set to hidden, 
only the batches you select appear in the Gantt Chart and Batch Trend. This is 
useful for viewing selected batch data from a query that returns many batches. 
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Custom Names Set 
Custom Names sets in PI ProcessBook are defined at the Batch Group level. This way, each 
Batch Group can have a different Custom Names set than another, even in the same display. 

To configure a Custom Names set for a Batch Group, select a Custom Names Set from a PI 
Server in the Custom Names Set drop-down list. To revert to the default Custom Names set, 
click Restore Default. For details, see Using Custom Names (page 121). 

Once you select a set in the Batch Definition dialog box and click OK, the Batch Group in 
the display updates. 

 

Edit PI ProcessBook Displays 

In Build mode, you can double-click any symbol in a Batch Group to open the Batch 
Definition dialog box for that Batch Group. 

 

Move and Resize Symbols 

You can move and resize individual symbols within the Batch Group on the display. The 
symbols within a Batch Group do not need to remain side-by-side as they are drawn by 
default. 

When you click any symbol within a Batch Group, you select the entire Batch Group. Once 
the entire Batch Group is selected you can move it around as a group of symbols. 

To move or resize an individual symbol within the Batch Group, select the entire Batch 
Group and then click the symbol you want to move. 

 

Synchronize Time Scale on Gantt and Trend 

By default, the Gantt Chart and the Batch Trends are drawn on the display so that the time 
scales are exactly aligned. If you edit the display, for example by resizing the Gantt Chart, 
you can resynchronize the time scales of the Gantt Chart and any Batch Trends that are in the 
same batch group. You can also synchronize additional Batch Trends by aligning them with 
other Batch Trends that are synchronized to the Gantt Chart. In addition, you can synchronize 
multiple Batch Trends to each other without a Gantt present. To do this: 

1. Drag either the Gantt Chart or Batch Trend toward the other. 

2. As the left edges of the two symbols come in proximity, the symbols snap together as 
shown by the outline of the symbol being dragged. Alignment is indicated by three 
arrows in each symbol pointing to the other symbol's arrows. 
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3. Release the mouse to drop the symbol back onto the display. The time scales of these two 
symbols are now synchronized. 

4. Rest your mouse over a symbol to see the symbols that its time scale is synchronized 
with. 

 

Save PI ProcessBook Displays 

When you save a PI ProcessBook display containing Batch symbols, only changes made in 
Build mode are saved. This is consistent with the behavior of other PI ProcessBook symbols 
such as the Trend. 

 

Relative and Absolute Times 

The Gantt chart and Batch Trend can show the data in absolute or relative time. In absolute 
time, all data on these plots appear at the actual time they occurred. In relative time, the data 
can appear relative to the start of a particular PIBatch, PIUnitBatch. The batch data can also 
be shown relative to PISubBatches using the alignment features of the Gantt Chart. 
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Limit Sets 

A limit set is a user-defined group of limits (similar to tags/traces) that you can apply to a 
trend symbol in the same way you can add tags. Limits have their own rendering styles 
(color, line width, line style, and markers) independent of the Batch Group's Color Scheme. 
Unlike regular traces, which are drawn once per batch, the limits are rendered only one time 
and show their entire data, including "future time" when the plot's time scale is Relative. If 
the plot's time scale is Absolute, the limits are drawn once per batch. The following figures 
show examples of Relative and Absolute time scale. 

PI BatchView supports the data sets created by PI ProcessTemplates as the data source for the 
limit sets. In the following figures, there are four traces: UL (Upper Limit), CL (Center Line), 
LL (Lower Limit), and Temp (the running batch's temperature). The current value appears in 
the trace legend under each trace, except for limits. Each trace represents a PI tag on the 
Batch Trend symbol. In the following figure, the limit set traces appear as follows: UL: 
white; CL: dashed white; LL: white; and Temp: green. 

 

Batch Trend in Relative Time Mode 
 

 

Batch Trend in Absolute Time Mode 
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PI ProcessTemplates 

PI ProcessTemplates is a separate product from PI BatchView. With PI ProcessTemplates 
you can create a data set for a process variable that is averaged across many batches. In the 
figure Batch Trend in Relative Time Mode shown in Limit Sets (page 53), the temperature 
at each minute during the batch was averaged across a number of batches to give the center 
line (average) and the upper and lower limits (2 sigma greater than and less than the average). 
With this information, you can observe your process variable and compare current process 
behavior to historical averages. Process Template data are stored on the PI Server, allowing 
access across your organization. 

PI BatchView supports the PI ProcessTemplates data set as a data source. The PI 
ProcessTemplates Add-In to PI ProcessBook must be loaded to use the Limit Sets feature. 

PI BatchView supports only those Process Templates created for full PIUnitBatches. 
Templates based on particular PISubBatches are not supported in this version. 

When using a limit set, it is better to query for the PIUnitBatches of a single PIUnit. This is 
because the limit set is based on a Process Template constructed for a process variable on a 
single PIUnit. 

Once the limit data are retrieved, they are not retrieved again until the trend is reverted (or 
any other action that causes a data refresh, such as editing, loading, or undo). To force an 
update to a limit set in a Batch Group, click the Revert Time Ranges button. 

See the PI ProcessTemplates documentation for details. 
 

Configure Limit Sets 

You can open the Configure Limit Set dialog box from any dialog box that has a tag list box 
(such as the Batch Definition and Configure Trend dialog boxes). Starting the Configure 
Limit Set dialog box from within PI ProcessBooks run mode, such as from the Tags/Aliases 
in Trend dialog box, only affects the run-time display of the Batch Group symbol and does 
not save the settings with the display. You can add, delete, and update limit sets only in the 
Configure Limit Set dialog box that is opened from the Batch Definition dialog box. 

The Limit Set… and Datasets… menu items are generated by add-ins loaded into PI 
ProcessBook. 
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In the Batch Group, each Trend supports one or more limit sets. More than one limit set may 
be needed on the same trend when more than one alias is plotted on the same trend. A limit 
set is needed for each alias. 

You can create or modify limit sets by choosing the source of the data, the number of limits 
in the set, and how the limits are to be rendered. The names of the limit sets must be unique 
within the Batch Group symbol. The length of the name is not restricted. The limit names 
must be unique within the limit set. 

To import limit sets from one Batch Group symbol to another Batch Group symbol within a 
display click Import in the Configure Limit Set dialog box. 

There is no maximum number of limit sets or limits that can be created within a limit set. 

The limits retrieve data from the Data Source based on the start time of the first batch 
processed. If no PIUnitBatch objects are in the batch group at the time the trend is reverted 
(or initialized), the trend waits for a PIUnitBatch to start in order to determine a start time of 
the limit's data. 

 

Effect of Plot Time Scale 
When the plot time scale is Relative, the Batch Trend displays the limit set once, regardless 
of the number of batches retrieved. When the plot time scale is Absolute, then the limit set is 
drawn once for each batch. 

 

Limit Set Traces 
In the Batch Trend, limit set traces are not selectable traces. Also, the legend does not display 
values of the limit set traces. 

The limits from Process Templates appear in future time. This means that the entire limit is 
drawn regardless of the current time. This makes it easier to see the how the running batch 
should look. 

 

Add a New Limit Set 

To add a new limit set: In the Batch Definition dialog box, click  next to the Tag 
Search… button and choose Limit Set… In the Configure Limit Set dialog box that 
appears, enter the limit set name. Each limit set name must be unique within the BatchGroup 
symbol. This field is automatically populated with Setn where n starts with 1 and is 
guaranteed to be unique when the dialog box opens to create a new limit set. For example, 
Set1. 
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For complete details on the Configure Limit Set dialog box properties, see Configure Limit 
Set Dialog Box (page 58). 

 

Add a New Limit 
To add a new limit: 

1. In the Configure Limit Set dialog box, click . The Data Sets dialog box appears. It 
lists the available data sources that limits can choose. 

 

2. Select a Data Set and the column(s) to add. If you select multiple columns, a limit is 
created for each column.  
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3. Click OK. Each column is added as a limit. 

Each limit name must be unique within the limit set. 

See the PI ProcessBook help file for general information on how to use the Data Sets dialog 
box. 

 

Import Limits from a Limit Set 
To import limits from a limit set: In the Configure Limit Set dialog box, click Import. The 
Import Limit Set dialog box that appears shows all open Display windows and 
ProcessBooks (.piw files). Expand the ProcessBook item to see a list of open Displays 
associated with the ProcessBook. Opened link entries of type Display are listed separately 
from the ProcessBook since they are not part of the ProcessBook. 

Expand the Display item to see a list of Batch Group symbols on the current display. Expand 
the Batch Group item to see a list of limit sets saved on the symbol. To select an available 
limit set click its name. Click Import to add all of the limits from the selected limit set to the 
current limit set. Only the open display windows in PI ProcessBook appear in this tree view. 

 

The Import Limit Set dialog box shows the limit sets in a tree view. Use the + and - buttons 
next to each item to expand and collapse the tree. Select the name of the limit set and click 
Import to add all of the limits from the selected limit set to the current limit set. You can 
import only one limit set at a time. 

To view a limit set before adding it, double-click the limit set, or select it and click 
Properties. A read-only Configure Limit Set dialog box appears with the limit set attributes. 

If the imported limit's name already exists in the limit set, then its name is "Copy of name" 
(where name is the limit name). If more than one copy exists, then its name is "Copy n of 
name" (where n is a duplicate's number). 
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IMPORT LIMIT SET TREE ICONS 

Each branch in the tree control has an icon that describes it: 

Icon Description 

 ProcessBook (.piw) window 

 
Display (.pdi) window 

 
Batch Group object in the Display 

 
Limit set within the Batch Group 

  

Edit a Limit Set 
You can edit an existing limit set from the Main tab of the Batch Definition dialog box or the 
Configure Trend dialog box. To do this, double-click the limit set in the Tags/Aliases (page 
24) list or select the limit set and choose Limit Sets… from the Tag Search drop-down list. 

 

Configure Limit Set Dialog Box 
You can add, modify or delete a limit set in the Configure Limit Set dialog box. To open 
this dialog box from the Batch Definition and Configure Trend dialog boxes, click  
and choose Limit Set… 

 

In the Name text box, enter a limit set name that is unique within the Batch Group. Click 
Import… to transfer the selected limit set from another Batch Group to this one. See Import 
Limit Set Dialog Box Controls for more details. 
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Limit Buttons 

 Creates a new limit and opens the Data Sets dialog box, where you can add a limit (page 
56). 

 Removes the selected limit from the limit set 

 Moves the selected limit up, changing the limit trace order on the Batch Trend 

 Moves the selected limit down, changing the limit trace order on the Batch Trend 
  

Properties 
The settings in the Properties area of the Configure Limit Set dialog box are: 

• Name: The limit name, which must be a unique name within the limit set. You can 
change the limit name here. 

• Data Source: The PI ProcessTemplates data set from which limit data is retrieved. Enter 
the data source name, or click  to open the Data Sets dialog box and select a data 
source. 

• Marker: A list of graphic symbols for the limit trace. 

• Color: The color of the limit trace drawn on the display. 

• Line Style: The type of line drawn for the limit trace (such as Solid, Dash, Dash Dot). 

• Line Weight: The thickness of the line drawn for the limit trace. 

Note: You can use wide line weights only with the solid line style.This option is 
disabled when the line style is not solid. 

 

Limit Set and Limit Naming 

Some restrictions on the naming conventions affect the limit set name and limit name. The 
limit set and limit names use the same constraints that the PI Server uses for tag names with 
one exception: the period character (.) is not allowed. The constraints are: 

• The first character must be alphanumeric (letters and numbers only). 

• The following characters are not allowed: 
* ' ? ; { } [ ] | \ ` " . 

 

Run Time Usage of PI ProcessBook Symbols 

Batch Group 

While the Batch Group symbol has no visible component, it provides the infrastructure for 
the four Batch symbols to share data and coordinate their behavior. All of the symbols 
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coordinated by the Batch Group symbol show the same batch results (for example, the same 
list of PIUnitBatches). A display can have multiple Batch Groups. 

 

Batch Search 

Every Batch Group must complete a search for batches to display the batches and their 
associated data. To change the batch search parameters directly from the display, include the 
Batch Search symbol. 

For details on search functionality see Setting Search Parameters (page 85). 
 

Restrict Parameters for Run Time Usage 
You can configure the Search Symbol using the Configure Search Dialog Box (page 28). 

You can configure the Batch Search to show only the search parameters that you want to 
allow display users access to. 

For example, a Quality Assurance worker may need to enter only the Batch ID to retrieve 
information about a particular batch. In this case, you would configure the Batch Search to 
show only the Batch ID field. 

The Search symbol in the display shows the search parameters used in the Batch Query in the 
Batch Definition dialog box. These parameters appear only for those portions of the Search 
Symbol that are visible in the display. 

For the parts that do not appear in the Batch Search symbol, you can set values at design 
time. Thus you can set up displays that are meaningful in the context you want to use them in 
while keeping the display simple. 

For example, perhaps the Quality Assurance worker needs to enter only the Batch ID for an 
analysis. While the Batch ID is the only element on this display, it might be useful to specify 
a time range or mask to search for only certain units. In these cases, you can specify the time 
range or unit search mask at design time in the Batch Definition dialog box. When the QA 
worker enters the Batch ID, the time range or unit search mask parameters are used to query 
for batches in addition to the Batch ID. 

You can make some or all of the search components visible at run time. If you make portions 
of the search visible at run time, then users see the query parameters you set in the Batch 
Definition dialog box as their defaults. 

For example, if the Time Range is visible on the display and you set the search for the last 8 
hours (*-8h to *), then these values also appear as defaults on the display. The user can then 
change the time range. On the other hand, if the Time Range is not visible on the display and 
you set it to the last 8 hours, then the query always uses the time range of the last 8 hours. 

When portions of the search are visible at run time and you change the search parameters, 
you must click Search to perform the new search and populate the other batch components. 
To indicate that a change was made and the search button has not been clicked, the button is 
highlighted and a triangle appears next to it. The Search button is also highlighted if you 
make changes by invoking the search control and performing a new search that differs from 
the search you would perform using the search parameters specified on the display. 
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At design time you can choose attributes such as Batch ID and Unit when you search for a 
PIUnitBatch. If you display these attributes in a display they are no longer drop-down lists 
but instead appear as fixed labels. 

 

Interactions 
To search using the edited parameters, edit the fields of the Search Symbol and click Search. 
The Batch Group then uses this search to show the retrieved batches and update the batches 
in real time. 

Similar to the Batch Definition dialog box, when any field on the Batch Search is edited, the 
Search button is highlighted to indicate that it must be clicked to display the new search 
parameters in the batch query. 

Running a new search replaces all the batches that are not anchored in the Batch Results 
Table. 

Note: Any changes you make to the search parameters in Run mode within the 
ProcessBook Display are not saved with the display. To permanently change the 
search parameters in the Display in Run mode, use the Batch Definition dialog 
box to modify the search parameters. 

 

Advanced Search Dialog Box 
You can also invoke the Search to change the batches retrieved in your display. To do this, 
right-click on any of the visible components (Batch Search, Results Table, Gantt Chart or 
Batch Trend) and choose Batch Search…. In the Advanced Search dialog box that appears, 
the search parameters are preset to the search specified in the Batch Definition dialog box 
and modified to include any changes from in-display search components. Clicking Search 
queries the PI Server(s) for batches and returns the results to the display, and any search 
components present on the display are updated with the search parameters. 

For details on using the Advanced Search dialog box, see Advanced Searches (page 97). 
 

Module Context 
A Batch Group's search can use the display's Module Context. For example, if there are two 
areas in your plant—Area 1 and Area 2—that have identical process equipment, you can 
create a single display and then switch between Area 1 and Area 2 by clicking their Modules 
in the Module Context docked window. The Batch Group symbol uses the Area 1 and Area 2 
Modules within its Unit Name search attribute to specify units within Area 1 or Area 2 only. 

For configuration details, see Module Context (page 91). 

For detail on using Module Context in PI ProcessBook, see the PI ProcessBook Help. 
 

Results Table 

The Results Table shows the batches returned from the search along with a configurable set 
of properties of the batches. For example, if the search returns PIUnitBatches, you can view 
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properties of the PIUnitBatches such as start and end times, the name of the unit in which the 
batch ran, the product made, and so on. 

In the Results Table, you can also anchor batches so that if you change the Batch Search, they 
remain in the table. You can show or hide each batch in the table in the Gantt chart and Batch 
Trends. 

Whether or not a Results Table Symbol appears in the display, each Batch Group contains 
one Results Table Symbol to coordinate the batch data among the Batch Group symbols. 

For details on all of the features of the Results Table, see Working with Results (page 103). 
 

Configuration 
Configure the Results Table using the Configure Results Dialog Box (page 29). 

 

Appearance 
The Results Table shows a hierarchical grid of the batch data within the Batch Group. 
Column headers indicate the information about the batch. Row headers show a color and a 
marker, corresponding to the colors and markers on the Gantt Chart and Batch Trend. 

 

Interactions 
Interactions with the Results Group affect searches and the display of batch information on 
the Gantt Chart and Batch Trend. 

Note: Any changes you make to the Results Table in Run mode within the ProcessBook 
Display are not saved with the display. To permanently change anchored items, 
sort order, column order, and so on, modify the Results Table using the Configure 
Results Dialog Box (page 29). 

 

Selecting a Batch 
When you select a batch on the Results Table, Gantt Chart, or Batch Trend symbols, the same 
batch is highlighted on all the other of these components in the display. 

 

Sort Batches 
The Results Table sort order controls the sort order for batches in the Results Table and Gantt 
Chart. That is, when you sort the batches in the Results Table, the order shown in the Gantt 
chart also changes. Colors associated with each batch are maintained when you sort the 
batches. 

Click a column header to change the sort order of the batches in the Batch Group. 
 

Anchor Batches 
Click a batch's anchor icon  to lock that batch in the display. This changes the batch color to 
the anchored color when using the Categorized or Anchored Classic color schemes. 
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If your search updates over time, anchored batches do not disappear from the results even 
when they do not satisfy the query parameters. 

 

Make a Batch Visible or Hidden 
Click a batch's visible/hidden icon /  to switch its visible property. Visible batches 
appear in the Gantt Chart and Batch Trend, while hidden items do not. 

 

Gantt Chart 

A Gantt chart is an easy way to look at your overall batch process and study batch cycle 
times. The PIUnitBatches viewed on the Gantt chart are coupled with the Batch Trend, 
providing a means for correlating batch events with process data. You can use the Gantt 
Chart to line up profiles of process data such as a reactor's temperatures during a heat cycle. 

 
 

Configuration 
Configure the Gantt Symbol using the Configure Gantt Dialog Box (page 30). 

 

Appearance 
The chart shown in Gantt Chart (page 63) contains three PIUnitBatches. The scrollbar on the 
right indicates there are more batches below. In this example, each PIUnitBatch is expanded 
to show the level of PISubBatches belonging to the PIUnitBatches. Colors on the Gantt chart 
correspond with the colors on the Batch Trend and are set in the Batch Definition dialog box. 
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Plus and Minus Signs 
A plus or minus sign on a Gantt bar indicates that the batch the Gantt bar represents has child 
batches. Click the plus or minus sign to expand or collapse the Gantt bar hierarchy. For 
example, clicking the plus on a PIUnitBatch expands the PIUnitBatch Gantt bar to show the 
PISubBatches that are children of the PIUnitBatch. 

 

Label 
Each Gantt bar has a label. By default, the label is the Batch ID for PIBatches and 
PIUnitBatches and it is the Name of the PISubBatch for PISubBatches. Labels that are too 
long to fit inside the bar are trimmed according to the setting in the Configure Gantt Dialog 
Box (page 30). 

 

Markers 
Markers drawn in the right of each Gantt bar correspond to the markers of the traces in the 
Batch Trend. 

 

Level in Batch Hierarchy 
Diagonal stripes in the corner of the Gantt bar indicate the absolute level of a Gantt bar. The 
stripes differentiate PIBatches, PIUnitBatches and three levels of PISubBatches. The stripe 
indicators are: 

Gantt bar Number of 
Stripes 

Batch item 

 
4 PIBatch 

 
3 PIUnitBatch 

 
2 PISubBatch 

 
1 PISubBatch, second level 

 
0 PISubBatch, third level and below 

Shading indicates the relative level of the Gantt bar. The base color for each batch is set in 
the Batch Definition dialog box. The top level bar in the Gantt Chart is the base color. A 
parent bar's child bars have different shades of the same base color. The shading increases as 
the number of levels from the parent increases. Light colors get darker and dark colors get 
lighter. There are four levels of shading. Any bars below the fourth level display the fourth-
level color. 
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Gantt Bar Start and End Time 
The ends of a Gantt bar indicate the position of the Start/End time along the time axis. The 
indicators are: 

Gantt bar Start/End Time Position Indicator 

 
Start Time  

 
Start Time Outside Gantt Time Range 

 
End Time  

 
End Time Outside Gantt Time Range 

The shape of the bar end indicates the position of the Start/End time along the time axis. A 
closed bar indicates that the Gantt symbol includes the actual Start/End time for the Gantt 
bar. A bump out on either end of the bar indicates that the Start/End time for that bar is not 
shown because it is outside the time range of the Gantt symbol. 

 

Gantt Bar Size 
The font size of the Gantt bar labels affects the height of the Gantt bars. This is the same font 
as the title and time scale on the Gantt Chart. You can set the font in the Configure Gantt 
Dialog Box (page 30). 

 

Interactions 

ToolTips 
Rest the pointer on a Gantt bar to show a ToolTip. The ToolTip provides information about 
the batch, including the Gantt bar label, start and end times, and duration. 

 

Selecting a Batch 
When you select a batch on the Results Table, Gantt Chart, or Batch Trend symbols, the same 
batch is highlighted on all the other of these components in the display. 

 

Properties Dialog Box 
To see more information on a particular batch, right-click its Gantt bar and choose 
Properties… The dialog box that appears shows the relevant properties depending on 
whether a PIBatch, PIUnitBatch, or PISubBatch is selected. You can copy these properties in 
tab-delimited form to the clipboard so that you can paste them into another application. 
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Properties dialog box for a PIUnitBatch 
 

Maximize 
Double-click the Gantt Chart to maximize it to the size of your display. Double-click again to 
reduce to the original size in the display. 

 

Gantt Cursors 
In the same way that you can draw a Trend Cursor on a regular Trend symbol, you can draw 
Gantt Cursors on the Gantt Chart and Batch Trend symbols. 

When you draw a cursor on the Gantt Chart, a Trend Cursor also appear on all Batch Trends 
within the Batch Group. 

If the Gantt Chart is too small you cannot draw a cursor. You can make the Gantt Chart larger 
in Build mode, or maximize the Gantt Chart and then draw the cursor. 

Similarly, if you draw a Gantt Cursor and it does not appear on your Batch Trend, it is likely 
the Trend Cursor will not fit in the Trend. You may be able to see the Trend Cursor by 
maximizing your Batch Trend or decreasing the number of batches or data sources displayed 
in the Batch Trend. 

 

Gantt Chart Right-Click Menu 
When you right-click a Gantt Chart without clicking on a Gantt bar, the menu items are: 

• Unalign: Returns Gantt chart and associated Batch Trends to unaligned state. 

• Batch Search…: Opens the PI BatchView Search (Advanced Search) dialog box. The 
search parameters are preset to the search specified in the Batch Definition dialog box 
and modified to include any changes from in-display search components. Click Search to 
query the PI Server(s) for batches and return the results to the display. Any search 
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components present on the display are updated with the parameters of the search. For 
details on the Advanced Search dialog box, see Advanced Searches (page 97). 

• Revert: Reverts the Gantt chart and thus any Batch Trend(s) to the view based on the 
Results Table and the settings within the definition dialog boxes. 

 

Gantt Bars Right-Click Menu 
In addition to the items from the Gantt chart shortcut menu, these items are also available 
when you right-click a Gantt bar: 

• Expand…and Collapse…: Choices are to expand or collapse "this item", "this item (all 
levels)", and "every label", where label is the Gantt bar label. For details, see Expanding 
and Collapsing Multiple Bars (page 69). 

• Show parent level: Shows the level above the current top level. For example, if 
PIUnitBatches are the top level displayed, selecting this shows the PIBatches that are 
parents of the PIUnitBatches. If two sibling PIUnitBatches were present initially, the 
parent PIBatch appears above both sibling PIUnitBatches. Alignments are preserved 
when using Show parent level. 

• Align to every item: Aligns to every Gantt bar matching the selected Gantt bar. The 
possibilities are: 
ο Align to every PIBatch: This appears when the PIBatch is the top level. 
ο Align to every PIUnit Unit: Where PIUnit is the full path to the PIUnit where the 

PIUnitBatch ran. This appears when PIUnitBatch is not the top level. For example, 
every PIBatch\PIBaGenFastTest Unit. 

ο Align to every PIUnitBatch: This appears when PIUnitBatch is the top level. 
ο Align to every PISubBatch Heading: Where PISubBatch is the path to the 

PISubBatch, including the PISubBatch name, and Heading is the PIHeading of the 
PISubBatch. This appears every time you align to a PISubBatch. For example: 

In a PIUnitBatch search: Align to every PIUnitBatch\mySubBatch1\mySubBatch2 
Operation 

In a PIBatch search: Align to every PIBatch\myUnit\mySubBatch1\mySubBatch2 
Operation 

This option aligns all the batches of like name and level. If there are no batches that 
match, nothing aligns within that batch. 

For more details on aligning, see Aligning Gantt Bars (page 73). 

• Properties…: Shows the Properties Dialog Box containing all the properties of the 
PIBatch, PIUnitBatch or PISubBatch. 
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Navigation 
You can zoom in or out to the level of the process you want to view in the Gantt chart. You 
can expand or collapse the Gantt bars to see the lower-level batch processes. You can also 
choose to show or hide the parent batch processes of the ones you are viewing. 

 

If you expanded the batches in the above Gantt Chart, you would see something like this: 

 

Bars occupying concurrent times appear on the minimum number of lines possible. In the 
green Aerate sub-batch (with two diagonal stripes), there are several other sub-batches that 
overlap the Aerate sub-batch's time range. These Gantt Bars appear on separate lines. 
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Plus and Minus Signs 
Use plus and minus signs to expand and collapse details of the batch processes, just as you 
would open and close branches of a tree view. A plus sign appears on a bar indicates that 
there are children of the bar that you can view. 

 

Expanding and Collapsing Multiple Bars 
In addition to the plus and minus signs, there are three ways to expand or collapse multiple 
bars. To do this, right-click a Gantt bar and choose an option from the following menu: 

 

The options are: 

• this item: Expands all the items one level below the selected bar. This is the same as 
clicking the Gantt bar's plus sign. 

• this item (all levels): Opens the selected item and all of its child items. 

• every item: Expands every item similar to the Gantt bar you have clicked. The text in this 
option depends on the selected item's Batch type: 
ο every PIBatch: This appears when the PIBatch is the top level. 
ο every PIUnit Unit: Where PIUnit is the full path to the PIUnit where the 

PIUnitBatch ran. This appears when PIUnitBatch is not the top level. For example, 
every PIBatch\PIBaGenFastTest Unit.  

ο every PIUnitBatch: This appears when PIUnitBatch is the top level. 
ο every PISubBatch Heading: Where PISubBatch is the path to the PISubBatch, 

including the PISubBatch name, and Heading is the PIHeading of the PISubBatch. 
This appears every time you expand a PISubBatch. For example: 
 
In a PIUnitBatch search: every PIUnitBatch\mySubBatch1\mySubBatch2 
Operation 
In a PIBatch search: every PIBatch\myUnit\mySubBatch1\mySubBatch2 
Operation 
 
This option opens all the batches of like name and level. If there are no batches that 
match, nothing expands within that batch. If there are multiple items within a batch 
that match the name of the item you want to expand, they all expand. 
 
For example, if you right-click and choose every Heat Operation for a PISubBatch 
named Heat and one of the other retrieved batches does not contain an Operation 
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named Heat, all the other Heat Operations except that one batch expand. Similarly, if 
a batch has two Operations named Heat, then both expand. 

The Collapse menu item has the same choices as the Expand menu item and functions the 
same, except that the Gantt bars collapse. 

 

Zooming 
In Run mode, you can zoom in on sections of the Gantt chart to limit the view of the batches. 
Zooming on the Gantt chart is different than on a standard PI ProcessBook trend or on the 
Batch Trend: in the Gantt chart the zoom depends on the item you select. 

The zoom behavior on the Gantt chart also depends on whether the data appears in Absolute 
or Relative time. In Absolute time mode, you zoom to the items you selected. In Relative 
time mode, you zoom to the context of the items you selected. 

ZOOMING IN ABSOLUTE TIME 

Zooming on the Gantt Chart in absolute time mode is similar to zooming on a trend. With the 
zoom you can change the time range that appears by picking certain Gantt bars to view. To 
do this, drag a rectangle around the Gantt bars you want to zoom in on. The Gantt Chart 
redraws to show only the Gantt bars you selected. The Gantt Chart's start and end times are 
determined by the Gantt bars you zoomed in on. 

Any zooming on the Gantt Chart also affects all Batch Trends in the group. These Batch 
Trends have the same start and end time as the Gantt Chart. 

Click Revert Time Range to revert to the time range set by the definition dialog box at build 
time. 

ZOOMING IN RELATIVE TIME 

When you zoom in Relative time, you: 

• Change the context of the top level shown 

• Change the breadth of the sibling batches displayed 

For example, in the following illustration, a box is drawn around the Aerate PISubBatch. This 
PISubBatch is selected and the view zooms to every Aerate PISubBatch that is a child of the 
PIUnitBatches at the top level of the Gantt Chart: 
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The results are shown below. This zoom effectively changes the context of the Gantt Chart 
and Batch Trends in the Batch Group from PIUnitBatches to the Aerate PISubBatches. 

 

The default zoom behavior does not align the resulting new top-level batches. But you can 
change this behavior to zoom and align in a single step for each Batch Group using the 
Configure Gantt Definition dialog box. In the above example, if the Zoom with Align 
setting were set to true, the Aerate PISubBatches would be aligned by their start times. 

Note: Zooming with align is equivalent to zooming and then aligning; thus there are two 
steps to undo the action: un-align and un-zoom. 

You can zoom in on multiple Gantt bars to change the context to that set of Gantt bars, as 
shown in the following figure. All bars that you select for zooming are highlighted as you 
drag the mouse pointer across them. 
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As the figure illustrates, if you drag your pointer to select a first-level PISubBatch and 
continue to drag the pointer to select the second-level PISubBatch, all of the items on the 
second level are selected. 

Discontinuous selections are not permitted when zooming. 

ZOOMING ON THE GANTT CHART AFFECTS THE BATCH TREND 

When zooming on the Gantt chart, traces on the trend are shown continuously for each trace. 
Gaps in traces are only shown between PIUnitBatches. 

When you perform a zoom operation on a Gantt Chart, it affects all of the Batch Trends 
associated with the Gantt Chart. Zooming on Batch Trends, however, does not affect the 
Gantt Chart. 

ZOOMING ON PISUBBATCHES 

When you zoom in on a PISubBatch, corresponding PISubBatches in the other PIUnitBatches 
are also zoomed in on. Corresponding PISubBatches are chosen based on the Name, 
PIHeading, and instance of the PISubBatch. 

For example, if there are multiple instances of Heat in the PIUnitBatch from which you 
zoomed and you zoom on the nth instance of a Heat Operation, then the Gantt chart zooms in 
on the nth instance of the Heat Operation PISubBatch in each of the PIUnitBatches. 

ZOOMING ON PIUNITBATCHES 

When PIBatches are the top-level batch displayed on the Gantt chart, you can zoom in on 
PIUnitBatches. When you zoom in on a PIUnitBatch, the corresponding PIUnitBatches are 
chosen if they ran in the same PIUnit. Zooming in on a PIUnitBatch selects that PIUnitBatch 
and all other PIUnitBatches within your PIBatches that were run within the same PIUnit. 

When multiple PIUnitBatches that were run in the zoomed PIUnit are found within a 
PIBatch, all of them appear. When you zoom without aligning, PIUnitBatches appear relative 
to the start of their parent PIBatch. If you zoom and align, all of the PIUnitBatches that were 
zoomed are aligned. 
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Aligning Gantt Bars 
Aligning the Gantt bars is useful for aligning data in the Batch Trend and analyzing cycle-
time. 

You can select one batch item and align this item across all the other batches. The following 
two figures illustrate how to align the batch data based on a batch in the Gantt chart. In the 
first, the user right-clicks the Unload PISubBatch of the PIUnitBatch to see the Align menu: 

 

The result is the Gantt bars align to the operation and the relative time is based on the 
operation start: 

 



View Batches in PI ProcessBook 

  
74 

   
 

When you align the Gantt bars, you also align the corresponding data in the Batch Trend. The 
following figure shows the Batch Trend that is aligned as a result of the actions in the 
previous two figures. 

The time axis of the Gantt chart and any trends are set to zero at the point of alignment. That 
is, time is now relative to the point of alignment: 

 

If you choose a PISubBatch and select this option, the chart searches for PISubBatches with 
the same Name and PIHeading. If you choose a PIUnitBatch and select this option, the chart 
searches for PIUnitBatches that ran in the same PIUnit. 

 

Batch Trend 

The Batch Trend displays data from PIPoints, PIAliases, or data sets for the time ranges 
based on the PIUnitBatches retrieved in the Batch Group. Each Batch Group can have one or 
more Batch Trends. Each Batch Trend can have one or more data sources. 

The traces plotted in the Batch Trend are coupled with the PIUnitBatches shown in the Gantt 
Chart. This provides a means for correlating batch events with process data. You can use the 
Gantt Chart for aligning batches to line up profiles of process data such as a reactor's 
temperatures during a heat cycle. 
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Continuous data is plotted for each PIUnitBatch in the Batch Group. When you search for 
PIBatches, the Batch Trend shows the data during times when the PIUnitBatches were active. 
During times within a PIBatch when there is no active PIUnitBatch, the trend shows a gap in 
the trace. 

If a PIAlias is not found for a PIUnit, no trace appears for the PIUnitBatches that ran in that 
PIUnit for that particular PIAlias. 

 

Configuration 
Configure the BatchTrend Symbol using the Configure Trend Dialog Box (page 32). 

 

Appearance 
There can be one or more data sources in a Batch Trend. Because the trace colors indicate 
different batches rather than data sources, line style—not color—indicates different data 
sources. 

One or more Batch Trends max exist within a Batch Group. You can synchronize the time 
axes of these Batch Trends with each other and the Gantt Chart. See Synchronizing Time 
Scale on Gantt and Trend (page 51) for details. By default, newly created Batch Group 
symbols synchronize the time axes of the Gantt Chart and all Batch Trends. 

Many options for the legend on the Batch Trend are available. For details, see Configure 
Trend Dialog Box (page 32). 

 

Interactions 

ToolTips 
To see a ToolTip with the time, value, alias, and Batch ID from the PIUnitBatch, rest your 
pointer over a trace. 

 

Select a Batch 
When you select a batch on the Results Table, Gantt Chart, or Batch Trend symbols, the same 
batch is highlighted on all the other of these components in the display. 

 

Maximize 
Double-click the Batch Trend to maximize it to the size of your display. Double-click again 
to return to the display. 

 

Trend Cursors 
In the same way that you can draw a Trend Cursor on a regular Trend symbol, you can draw 
Trend Cursors on the Gantt Chart and Batch Trend symbols. 

Trend Cursors drawn on a Batch Trend only appear on that Batch Trend. If the Batch Trend is 
too small, you cannot draw a Trend Cursor. You can either make the Batch Trend larger in 
Build mode, or maximize the Batch Trend and then draw the Trend Cursor. You may also 
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need to decrease the number of batches or data sources displayed in the Batch Trend to draw 
a Trend Cursor. 

 

Shortcut Menu 
When you right-click a Batch Trend, the menu that appears has the following options: 

• Batch Search: Opens the PI BatchView Search (Advanced Search) dialog box. The 
search parameters are preset to the search specified in the Batch Definition dialog box 
and include any changes from in-display search components. Click Search to query the 
PI Server(s) for batches and return the results to the display. Any search components on 
the display are updated. For details on the Advanced Search dialog box, see Advanced 
Searches (page 97). 

• Revert: Removes all scrolling and zooming and returns the trend to the original time 
range either based on the Gantt chart if present in the Batch Group or the settings in the 
definition dialog boxes. 

• Tags/Aliases in Trend…: Opens the Tags/Aliases in Trend dialog box. For details on 
the options in this dialog box, see Batch Definition Dialog Box, Main Tab (page 22). Any 
change you make with this dialog box persists in run time only and does not persist when 
you save the display. 

 
 

Aligning Traces 
To align traces in the Batch Trend, use the Gantt Chart align features. Alignments made to 
batches in the Gantt Chart also align the traces in the Batch Trend. For details, see Aligning 
Gantt Bars (page 73). 

 

Updates 

The Batch Group updates its batch data in two ways: it updates the results from the query and 
it updates any changes to batches that appear. 

The Batch Group can automatically update the batches in its results list when a new batch 
starts. The default Batch Group behavior is to update each time PI ProcessBook updates. You 
can also set the Batch Query to update only when the display loads. Alternatively, you can 
turn off the Batch Query. These options are available in the Batch Definition Dialog Box, 
Settings Tab (page 41). 
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Updates are made continuously to batches shown on the display. For example, batches that 
are in progress display new child batch objects as they are created. Edits to running or 
completed batches are also updated on your display. 

By default, PI ProcessBook updates every 5 seconds. If your Batch Query takes a significant 
portion of the update time, the update occurs less frequently. This management helps to 
update the display with reasonable frequency while allowing users to interact with the 
display. 

 

Understand PI BatchView Error Indicators 

When you open a display containing a Batch Group or a 2.1 version Batch Trend that has 
Anchored batches or Fixed batches (from a version 2.1 Batch Trend) that are not found, the 
Batches Not Found dialog box appears. 

The dialog box shows attributes of the batches not found. If these batches have been 
permanently removed from the PI server you may want to remove them from the display to 
avoid seeing this dialog box each time you open the display. To remove an Anchored or 
Fixed batch from the display, check the box to the left of the batch. Click OK to close the 
dialog box and remove the checked batches from the display. 

To load the display without deleting any batches, leave the boxes unchecked and click OK. 
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PI BatchView Preferences 

When you create a new Batch Group symbol, it obtains many of its settings from the PI 
BatchView Preferences in PI ProcessBook. These preferences are applied to new Batch 
Group symbols but—with one exception—do not apply to Batch Group symbols that were 
previously created. You can change these preferences in the ProcessBook Preferences 
dialog box. 

The Maximum Traces on a Trend setting applies to new and existing Batch Groups. 

To access these settings, choose Tools > Preferences. In the ProcessBook Preferences 
dialog box that appears, click the PI BatchView tab. 

 

The PI BatchView tab includes settings for color scheme and symbol configuration. 
 

Color Scheme 

The Color Scheme area determines the default color scheme as well as the colors and marker 
types for that scheme used in a new Batch Group (page 59) symbol. Once you create a Batch 
Group, these preferences are not reapplied. 

The scheme selected is the preference for a new Batch Group. To change to color and marker 
preferences within a scheme, select that scheme and then edit the color and marker for each 
trace. 
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Note: The Color drop-down list does not close until you select a color or click outside the 
box. 

 

Visible Symbols 

Indicate which symbols you want to appear in your displays by default. 
 

Maximum Traces 

For better performance, it is useful to limit the number of traces on the Batch Trend (page 
74). The default is 200 but the maximum is 500. The amount of data shown in 500 traces 
within one trend requires a significant amount of time to retrieve from the PI Archive. At 
some point, adding extra traces to the trend either does not add any more information about 
the process or makes a complex trend even more difficult to interpret. Thus, this setting can 
prevent expensive and often unnecessary archive retrieval. 

Tip: If you want to use a significantly large number of traces in order to find outliers, 
you can use the Filter Expression (page 95) of the Batch Search parameters to 
filter out most of the "normal" traces. 

Using the default of 200, if there is one alias, you can show 200 batches. If there are two 
aliases, you can show 100 batches, and so on. If there are more than 200 traces to show, all 
batches for the first alias appear first. Then all batches for the second alias appear until there 
are no more batches to show. 

Exceeding the 200 trace limit may lead to unexpected updating behavior. New batches do not 
appear if there are over 200 batches to draw. For example, a new running batch cannot be 
added unless an old one is removed. A warning icon appears on the Batch Trend when it 
reaches this limit. 

 

Symbol Configuration 

This area determines the initial settings that appear in the definition dialog box of a new 
Batch Group symbol for each of the four Batch Group component symbols. Click the picture 
of each symbol to open a preferences dialog box for that symbol. 

Use the Batch Search Preferences dialog box to configure the default appearance of the 
Search symbol in a new Batch Group (page 59). It behaves exactly like the Configure Search 
Dialog Box (page 28). 

Use the Batch Results Preferences dialog box to configure the default appearance of the 
Results Table symbol in a new Batch Group (page 59). It behaves exactly like the Configure 
Results Dialog Box (page 29). 

Use the Batch Gantt Preferences dialog box to configure the default format of the Gantt 
Chart (page 63) in a new Batch Group. It is organized differently than the Configure Gantt 
Dialog Box (page 30) but behaves identically and contains the same elements. 
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Use the Batch Trend Preferences dialog box to configure the default format of each Batch 
Trend (page 74) in a new Batch Group. It appears and behaves almost exactly as the Format 
tab of the Configure Trend Dialog Box (page 32). 

Preferences for scale and plot time are not currently available. 
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PI BatchView provides these programming interfaces: 

• ActiveX controls 

• PI ProcessBook Programming Interface 

Programmatic access is designed mainly for VB and VBA, especially VBA within PI 
ProcessBook and Microsoft Excel. Other languages that provide access to COM, such as 
C/C+, can also access the libraries. 

For details on the programming tools, see the online programming help file 
PIBatchViewProgramming.chm. In a typical installation, this file is located at 
InstallPath\PIPC\HELP\. For example, C:\Program Files\PIPC\HELP. 

 

Integrate PI BatchView into Applications with ActiveX Controls 

PI BatchView contains several libraries of COM components that provide programmatic 
access to its searching capabilities. These libraries include several Search and Results 
(ActiveX) controls that provide user interface elements to the underlying criteria and search 
components. 

 

Customize the Batch Group Symbol in PI ProcessBook 

You can automate the Batch Group symbol in PI ProcessBook. For details, see the online 
programming help file PIBatchViewProgramming.chm. 

 

Chapter 5 

Use the PI BatchView Programming Interfaces 
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The following sections describe how to use the features that are common to all PI BatchView 
tools: 

• Setting Search Parameters 

• The Results Table 

• Custom Names Sets 
 

Part II 

Common Features of PI BatchView 
Tools 
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When used together, the search parameter components provide for a flexible and powerful 
search query. The components are: 

Component Name Description 

Selection Component Specifies the number and type of batches to return 

PI Servers Component Specifies which PI Servers to search from 

Time Range Component Specifies the time range to limit the search to 

Attributes Component Specifies masks for batch attributes 

Duration Component Specifies the batch duration range 

Filter Component Specifies a filter expression to test archived data 
  

Selection Component 

The Select area specifies the number of results to return, the type of batches, and whether or 
not they have completed. 

 
 

Selection Mode 

 

Use this drop-down to limit the number of items returned by the search. The options are: 

• All: The search returns all results that it finds. 

• The First: The search results are limited to the first (least recent) items of all those 
found; that is, those items with the oldest start times. The Count parameter specifies the 
number of items to return. 

• The Last: The search results are limited to the last (most recent) items of all those found; 
that is, those items with the most recent start times. The Count parameter specifies the 
number of items to return. 

 

Chapter 6 

Set Search Parameters 
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Count 

 

This up/down box specifies the maximum number of batches the search can return. 

The actual number of results returned depends on the Selection Mode parameter. For 
example, if the Count is 20 and the Selection Mode is The Last, then the search returns the 
most recent 20 items (based on their start time). If the Select Mode is All then the Count 
parameter is irrelevant and the up/down box is disabled. 

The Count parameter ranges from 1 to 999. 

You can change the value of the up/down box in any of the following ways: 

• Enter a number in the box 

• Press the up and down buttons in the box to increment and decrement the count by 1. 

• Press the Up and Down keys on the keyboard to increment and decrement the count by 1. 

Holding the buttons and keys described here continuously increases or decreases the count 
and after a few seconds it accelerates. Thus, you can reach larger numbers more quickly. 

 

Batch Type 

 

This drop-down list specifies the type of batches that the search returns. The options are: 

• PIBatch: The PI Batch Database PIBatch entity. 

• PIUnitBatch: The PI Batch Database PIUnitBatch entity. 

The search returns only batches of the type that this parameter specifies, regardless of any 
other parameters that are set. 

 

Include 

 

The Include parameter specifies which batches to return, based on whether or not they have 
completed. The options are: 

• Running: Return only running batches. These are items that do not yet have an end time 
defined. 

• Completed: Return only completed batches. These are items that have an end time. 

• Both: Return both running and completed batches. 
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PI Servers Component 

The PI Servers box specifies the PI Servers to search. 

 

The PI Servers available are those defined on the local computer by the PI SDK and shown in 
the PI SDK Connections dialog box. 

Click a server to select it, or to select multiple servers, click the Select Multiple Servers 
check box and select multiple servers. 

 

You can also select servers by pressing the Up and Down keys and the space bar. 

When multiple servers are selected, they appear in the box separated by commas. If all the 
server names do not fit in the box, an ellipsis (…) truncates the list. Rest the pointer over the 
box to see a ToolTip showing the complete list. 

 

If a PI Server name appears with brackets ([]) around it, the server is missing. This happens if 
the PI SDK has removed the server definition or the Server's component was populated on 
another computer that defines different servers. 

For example, a user places the PI Servers component in a PI ProcessBook display, adds the 
server Huckleberry, and saves the display. If a user opens that display in PI ProcessBook 
on a different computer where Huckleberry is not defined, the component contains 
Huckleberry, but only to preserve the integrity of the display. In the PI Servers box, the 
missing server appears as [Huckleberry] - Missing. 

If you deselect a missing server in the list, it no longer appears in the drop-down list. To 
restore it, use the PI ProcessBook Connections dialog box to add the server. 

Performing a search against a missing server yields zero results for that server. 
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Time Range Component 

The Time Range component specifies a search's beginning and end times. 

 
 

Activity State 

 

The activity state options are: 

• Started: Each batch start time must be within the time range specified. 

• Active: Each batch must be active at some time during the time range specified. It may 
start before or end after the time range specified. 

• Entirely: Each batch must start and end entirely within the time range specified. 

• Ended: Each batch end time must be within the time range specified. 

The time range boundaries are inclusive so that if a particular time of the batch is the same as 
one of the time parameters then it is considered to be within the range. 

 

Time From and Time To 

The Between and and boxes are the TimeFrom and TimeTo parameters. They specify the 
time range that the search is bound by. 

 

The Activity State parameter specifies whether or not an item is considered to be within this 
range. 

The drop-down lists contain basic time entries, including *,*-1 Minute, *-1 Hour, *-8 Hours, 
*-1 Day, and *-7 Days. You can also enter other values. For details on valid values, see PI 
Time and Relative Time (page 98). All Windows formats (in the format of the locale setting) 
are also valid. 

Times can be relative to each other. This means that TimeFrom can be an interval that is 
added to TimeTo, or vice-versa. For example, if TimeFrom = "21-Oct-03 17:30" and TimeTo 
= "+ 30 minutes" TimeTo is equivalent to "21-Oct-03 18:00". If TimeFrom = "-8 h" and 
TimeTo = "*-1 d" TimeFrom is equivalent to "*-1d - 8h". 

If both TimeFrom and TimeTo are intervals, then TimeFrom is considered relative to the 
current time. 

The order of TimeFrom and TimeTo makes no difference to the way the search is done. 
Results are ordered by start time descending. 
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Attributes Component 

The Attributes component specifies the attributes of each item to test for a match with a text 
mask. 

 

The following sections describe the Selection component parameters. 
 

Attribute Selection 

 

This drop-down lists the attributes that are available for masking. The attributes available for 
each batch type are: 

PIBatch PIUnitBatch PISubBatch 

Batch ID Batch ID Name 

Product Product Heading 

Recipe Name Unit Name   

  Procedure   

  Unit Heading   

Each of these is a text attribute that can be compared with a Mask List (page 90) to test for 
inclusion in the returned results list. 

The maximum number of visible Attribute Selection drop-down lists is determined by the 
number of available attributes of the batch type that the component pertains to. For example, 
if an Attribute component pertains to PISubBatches, then it can display a maximum of two 
Attribute Selections. See Advanced Searches (page 97) for more details. 

A single Attribute only contains attributes that are not already displayed in other visible 
Attributes. For example, if three PIUnitBatch Attributes are visible and the first two are set to 
Batch ID and Product, then the third has a choice between the remaining PIUnitBatch 
attributes: Unit Name, Unit Heading and Procedure. 

In Excel, a Unit Name module path can be specified without the server.  If no server is 
specified in the module path, the unit specified is searched for on all servers specified in the 
PI Servers component.  To specify a module path without the server, the first character must 
be a "\".  For example: 

\Plant\Line1\Reactor 
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Mask List 

Each Attribute Selection (page 89) parameter is coupled with a Mask List parameter. A mask 
is a string that is compared with the value of a specific attribute in each batch. 

You can enter multiple masks, separated by commas. The relationship between these masks is 
logical OR. For example, the mask list: 

 

returns batches whose Batch ID property is "XYZ123", "XYZ789", or "ABC000". 

The mask list elements may contain the * and ? wildcard characters. The * matches zero or 
more characters in a string and the ? matches any single character. For example, the mask 
list: 

 

could return batches with Batch IDs like XYZ123, XYZ127, XYZ12A, JKL789, 
JKSS010816, ABC006, and A16. 

If you change the Attribute Selection (for example, from Batch ID to Unit Heading) then the 
contents of the mask list do not change, but instead are applied to the new attribute. 

 

Unit Names 

 

Use the Unit Name parameter to specify PIUnits as well as unit masks. If you specify one or 
more PIUnits, the search is performed for those PIUnits as well as any unit masks that are 
specified. 

Use the entire PI Module Database path (including the PI Server name) to specify a PIUnit. 
For example: 

 

The full path for the selected unit Reactor2 is 
\\Localhost\PI-BaGen\Reactor2\ 

where Localhost is the PI Server where Reactor2 is defined. Wildcard characters do not 
apply to module paths. 
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Tip: To optimize the batch search speed, use specific units. Searching with a specific 
unit or a list of specific units is faster than searching with a unit mask. 

 

Module Context 

When used in ProcessBook, masks in the mask list can be PIModule context-aware. A 
context-aware mask has the form of %ModuleContext% and can be entered directly into 

the mask list. Alternatively, click  in the Unit Name Mask Selection Dialog Box to insert 
this mask. 

The batch search uses a module context-aware mask by retrieving the current PI ProcessBook 
module context and applying it to the mask. It uses simple text replacement to replace the 
%ModuleContext% with the full path of the PIUnit in context. 

When used by itself, the context-aware mask is useful for switching the PI ProcessBook 
context between actual PIUnits. In cases where the PIUnit is a child of a PI ProcessBook 
context, you can append the context-aware mask with the appropriate path. For example, for a 
context of \\Localhost\Plant\Line1, %ModuleContext%\Reactor becomes 
\\Localhost\Plant\Line1\Reactor. 

If a PI ProcessBook context causes the mask to resolve to a PIModule instead of a PIUnit, the 
search produces no results for that mask. 

 

Unit Name Mask Selection Dialog Box 

You can enter a module path directly into the Mask List text box. For most modules, this can 
be tedious. Click the ellipsis button (...) next to the mask text box to open the Unit Name 
Mask Selection dialog box. In this dialog box you can define unit masks and select units 
from the PI Module Database to include in the Unit Name List. 
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All of the items in the Unit Name list appear in this dialog box. If you specify a unit and its 
path does not exist, it does not appear. The unit is removed from the list after you click OK 
and remains if you click Cancel. 

 

Available Units 
The left side of the Unit Name Mask Selection dialog box shows a module tree that lists all 
PIModules and PIUnits. Using this tree you can easily locate and select units, and create 
masks. When you highlight an item in the tree, its full path appears in the text box above the 
tree. You cannot edit this path. To copy the path to the clipboard, select it and press Ctrl+C. 

A unit that is checked in the tree is hidden if its parent item is not expanded. To assist in 
locating a hidden unit, its parents in the tree appear in bold typeface. 

 

When a unit in the list is highlighted, the corresponding unit in the tree is also highlighted, 
and vise-versa. Thus, you can easily find a unit in one view by highlighting a unit in the 
other. If one has scrolled out of view, it comes back into view if you highlight the other. If a 
unit in the list is highlighted and that unit in the tree is hidden, all of its parents expand to 
unhide it. 

If possible, the full path of each unit in the list appears; otherwise it is shortened for display 
purposes. Rest the pointer over the item to display a ToolTip showing the full path. 

 

Units and Unit Masks 
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The list on the right side of the Unit Name Mask Selection dialog box shows current units 
and unit masks. The icons for units and unit masks are: 

Icon Description 

 Unit mask 

 Unit 

 Module context 

The list has a Unit/Mask and Path column, which shows the full path for units. Thus, you can 
distinguish units of the same name by their path in the tree. 

You can edit the list in several ways: 

• Click  to create a blank entry below the last item. Enter a new mask. 

• Double-click an existing mask to edit it. 

• Select a PIUnit or PIModule from the Module tree on the left side of the dialog box and 
click  to create a new mask with the same name as the selected tree item. 

• Select an item and click  to remove it from the list box, or press Delete on the 
keyboard. 

• To add or remove a PIUnit, check or uncheck its box in the tree. 

 

• Within PI ProcessBook, click  to add a PI ProcessBook module context mask. 
 

Duration Component 

In the Duration component, you can specify the range of batch durations for the search. 
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The component specifies the duration of only the batch type it pertains to. This is useful for 
situations where, for example, a search query is configured to return PIUnitBatches where a 
particular PISubBatch of each item is longer than a particular duration. In this case, the 
duration of the item being returned is not of concern but the duration of its sub-items. See 
Advanced Searches (page 97) for more details. 

The following sections describe the Duration component parameters. 
 

Duration State 

 

In this box, specify the comparison state of the duration of each batch. The options are: 

• Any Length: Each batch can be of any duration. When this is selected the Duration 
Period boxes are unavailable, since no comparison is needed. 

• Shorter Than: Each batch must be shorter than or equal to the duration specified in the 
first Duration Period box. The second Duration Period box is unavailable for this option 
because it does not apply. 

• Between: The duration of each batch must be within the range specified in the Duration 
Periods boxes. The periods can be in ascending or descending order, or can be the same 
to specify an exact duration. 

• Longer Than: Each batch must be longer than or equal to the duration specified in the 
first Duration Period box. The second Duration Period box is unavailable for this option 
because it does not apply. 

 

Duration Periods 

 

Use the Duration Period boxes to specify a search's duration range. Depending on the 
Duration State parameter value, one or both of the boxes may be disabled. 

The Duration Period boxes include basic time entries in their drop-down lists, including 1 
Minute, 1 Hour, 4 Hours, 8 Hours and 1 Day. You can also enter other values in the boxes. 
The first Duration Period does not need to be smaller than the second; the order does not 
affect how the search is run or results are returned. 

 

Filter Component 

If the filter expression evaluates to TRUE for the specified period for a particular batch, then 
the search returns that batch. 
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The search also tests the expression against the period for which the expression was true. This 
period is cumulative over the item's time range. For example, if the expression was true for 2 
minutes at the beginning and then 5 minutes somewhere in the middle, the cumulative time 
that the expression was true is 7 minutes. 

The component specifies the filter for archived values between the start and end times of a 
batch type. This is useful when, for example, a search query is configured to return 
PIUnitBatches where the archived value of "Sinusoid" during a particular PISubBatch of each 
item is less than 50. See Advanced Searches (page 97) for more details. 

 

Filter Expression 

 

In the Filter Expression text box, you can enter an expression is in the PI Performance 
Equation syntax format. For details on this syntax, see the section on Performance Equations 
Subsystems in the PI Server Applications User Guide. 

You can specify PI tags in single quotes ( ' ) (for example, 'Sinusoid'). PIAliases are not part 
of the native syntax but you can use them in the filter expression with single quotes (for 
example, 'Temp'). The filter expression attempts to evaluate aliases before it evaluates PI 
tags. 

Aliases are available only in PIModules (including Modules that are designated as PIUnits). 
If the filter expression component pertains to a PIUnitBatch or PISubBatch, you can use 
aliases from the unit. The syntax is the same as that of tags, enclosed in single quotes. 

Note: PIAliases have priority over PI tags. If a PIModule (or PIUnit) contains an alias that 
is the same name as a PI tag, the alias takes priority; otherwise the tag is used. In 
this case, if all the units of the PIBatches found except one contain a particular 
alias, then the expression on the one is inconsistent because its value comes from 
the tag, rather than from the desired (yet non-existent) alias. 

Aliases are not supported for expressions of Filter components that pertain to PI Batch 
Database PIBatch items. 

 

Filter State 

 

Use this box to specify the comparison state of the period for which the Filter Expression 
(page 95) is true. The options are: 
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• Any Time: The expression must be true at any time during the batch's time range. This 
applies even if the expression was true for only 1 second or for the whole time. Both 
Filter Periods (page 96) are unavailable for this option because they do not apply. 

• Less Than: The expression must be true for a period less than or equal to the value of the 
first Filter Period parameter. This allows the expression to be false for the whole of the 
batch's time range. The second Filter Period parameter is unavailable for this option 
because it does not apply. 

• Between: The expression must be true for a period greater than or equal to the lower 
boundary and less than or equal to the upper boundary of the range specified by the Filter 
Period parameters. 

• Greater Than: The expression must be true for a period greater than or equal to the 
value of the first Filter Period parameter. This allows the expression to be true for the 
whole of the batch's time range. The second Filter Period parameter is unavailable for this 
option because it does not apply. 

• Always: The expression must be true for the whole of the batch's time range. 

• Absolute: The times used to evaluate the filter expression are defined within the 
expression itself. You can specify the batch's start and end time within the expression 
using the ST and ET buttons.  For example, to retrieve only batches where the average 
temperature is greater than 100, use the expression: 

tagavg('temperature','[S]','[E]")>100 

The ST button inserts the string [S], a placeholder for the batch start time.  The ET 
button inserts the string [E], a placeholder for the batch end time. 

 

Filter Periods 

 

Use the Filter Period boxes to specify the range of the periods to which the Filter Expression 
(page 95) test is bound. One or both of the boxes may be disabled, depending on the value of 
the Filter State (page 95) parameter. Batches are returned only if the Filter Expression 
parameter evaluates to true for a period during this range (in conjunction with the Filter State 
parameter). 

The Filter Period drop-down lists contain basic period entries, including 1%, 10%, 50%, 
90%, and 99%. You can also enter other values in the boxes if needed. A percentage value 
specifies a percentage of the batch's duration. For example, if a Filter component for 
PISubBatches specifies 20% for the first Filter Period, then that is equivalent to 12 seconds 
for a 1-minute PISubBatch, 11 minutes for a 55-minute PISubBatch, and so on. 

Although the drop-down lists contain only percentage values, you can also enter static time 
periods in either box. For example, "90 Seconds", "3 Minutes", and "2.3 Hours" all specify 
actual time periods for the range. 

The first Filter Period value does not need to be smaller than the second Filter Period value. 
The order does not affect the way the search is run or results are returned. 
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Advanced Searches 

You can specify the parameters used to search for batches, whether it be PIBatches or 
PIUnitBatches, for any area of an item's hierarchy. Although the Batch Type (page 86) 
parameter of the Selection Component (page 85) determines what kind of batch to return, 
some parameters are not restricted to one type of item; they can also extend to items above or 
below them in the hierarchy. 

For example, the search query may return PIUnitBatches but contain parameters such that the 
PIBatch (parent) of each PIUnitBatch has a particular Recipe name and each PIUnitBatch 
contains a particular PISubBatch. 

The parameter components that you can use in this way are: 

Attributes Component 
(page 89) 

 

Duration Component 
(page 93) 

 

Filter Component (page 
94) 

 

You can access advanced searches through the Advanced Search Dialog Box (page 97) of the 
PI ProcessBook and Microsoft Excel add-ins and the PI BatchView QuickSearch (page 7) 
utility. It may also be available in custom applications not included in PI BatchView. 

 

Advanced Search Dialog Box 

The Advanced Search dialog box shows the search parameter components described in 
previous sections, as they would normally appear, with one exception. The Attributes 
Component (page 89), Duration Component (page 93), and Filter Component (page 94) are 
each located in a tabbed display. The tabs represent the parameters for PIBatches, 
PIUnitBatches, and PISubBatches. Each tab has one of each of the parameters. 

The tab that represents the parameters for the type of batch being searched for contains a 
magnifying glass icon ( ). For example, in the following figure, the Select area shows that 
the search will look for PIUnitBatches. Therefore the PIUnitBatch Criteria tab contains the 

 icon. 
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Note: Applications other than those included with PI BatchView may not include the 
same Advanced Search dialog, and therefore the parameters may be arranged 
differently. 

 

Time and Interval Strings 

PI BatchView supports PI SDK time strings for times and periods (or intervals). The 
supported string formats are PI time, relative time, interval arithmetic, ISO 8601 time and 
local system time as indicated by regional settings. 

 

PI Time and Relative Time 

The format for PI Time is dd-MMM-yy hh:mm:ss (for example, 23-Jun-02 14:23:01) with the 
options of a long month (June), 4-digit year (2002), and fractional seconds (14:23:01.125). 
Any part omitted from the date defaults to the current day, month, or year. Any part omitted 
from the time defaults to 0. 

The following examples apply for Friday, 23-March-2003 2:34:56. These are the US English 
defaults. 
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Example Resulting Date and Time 

7 or 7: Friday, 23-Mar-03 07:00:00 

7:25 or 7:25: Friday, 23-Mar-03 07:25:00 

:25: or :25 Friday, 23-Mar-03 00:25:00 

::42.125 Friday, 23-Mar-03 00:00:42.125 

7::42 Friday, 23-Mar-03 07:00:42 

7:25:42.125 Friday, 23-Mar-03 07:25:42.125 

18-Aug-98 Tuesday, 18-Aug-98 00:00:00 

18-Aug 7:25 Monday, 18-Aug-03 07:25:00 

August Saturday, 23-Aug-03 00:00:00 

August 1998 Sunday, 23-Aug-98 0:00:00 

1998 Monday, 23-Mar-98 00:00:00 

August ::25.125 Saturday, 23-Aug-03 00:00:25.125 

Because of the above assumptions about missing date parts, some PI times are relative. For 
example, the date generated by "Aug 98" is different every day. PI time also includes 
constants for other relative times. These include: 

Example Resulting Date and Time 

* The current time 

Today or t 00:00 (midnight) of the current day 

Yesterday or y 00:00 (midnight) of the previous day 

Sunday or sun 00:00 (midnight) of the previous Sunday * 

... Including all of the days of the week 

Saturday or sat 00:00 (midnight) of the previous Saturday * 

* The "previous" weekday includes the current day, not the current day of last week. 
 

Interval Arithmetic 

In some cases, specific times and relative times are insufficient for specifying a desired time. 
PI time provides greater flexibility by supporting interval arithmetic. You can add or subtract 
pre-defined and custom-built time intervals in any PI time interval, multiple times. 

The following pre-defined intervals are useful to interval arithmetic. Custom intervals are 
also supported. For details on custom intervals, see the example under the ITimeIntervals 
topic of the PI SDK online help. 

Interval Short Format Plural Format 

Second s Seconds * 

Minute m Minutes * 

Hour h Hours * 
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Interval Short Format Plural Format 

Day d Days 

Week w Weeks 

Month mo Months 

Year y Years 

* These intervals support fractions. 

An interval is not complete without a numeric part. For example, "day" is not a valid interval 
but "1 day" is valid (the space is optional). The numeric part of hours, minutes and seconds 
may be fractional. For example, "1.25m" is 1 minute and 15 seconds. Fractional days, weeks, 
months, and years are not supported. 

The format of interval arithmetic is: 
time  +/-  NumberInterval [+/-  NumberInterval] 

If the time parameter is omitted, current time is assumed. Some examples are: 
* - 1 day 
 
T + 2.1 hours 
 
* - 3 weeks + 36h - 3.4 sec - 1 year 
 
Tue + 1 month 

Due to the irregularity of days, months, and years, these intervals are not specific lengths. 

Days: The result is at the same time of the resulting day. Even if the result spans a daylight 
saving time transition (making a day 23 or 25 hours), the time is the same. 

Months: The result is the same time and day of the resulting month. If the resulting month 
does not contain the corresponding day, the result is the last day of the month instead. For 
example, on 31-Jan-04 "T + 1 month" results in 29-Feb-04. 

Years: The result is the same time and date of the resulting year. If the resulting day is Feb 
29 but the resulting year is not a leap year, the result is Feb 28. 

 

ISO 8601 Time 

The ISO 8601 time format is in the form of: 
year-month-dayThour:minute:second 

Note that a T separates the date and the time. For example: 
2003-03-23T02:34:56 

 

Local System Time 

The local system time format is the format specified in Windows as the long and short date 
and time settings in Windows regional settings. These contain month and day strings 
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localized by the operating system, configurable ordering of the date, configurable date 
separators and configurable time separators. The local system time format is extended to 
allow a fractional second to be specified. 
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Use the Results Table Configuration component to define the appearance of the Results 
Table. 

The Results Table contains the Result Items of one or more searches. It shows the immediate 
details of each batch, its hierarchy, and various attributes. 

 
 

Result Items 

Each result item appears in a single row of the table and represents either a PIBatch or a 
PIUnitBatch. The content of a row depends on what columns are displayed. A result item has 
the following attributes: 

Attribute Description 

Hierarchy (page 104) Shows the parent-child relationship of PIBatches, PIUnitBatches and 
PISubBatches 

Markers and Colors 
(page 104) 

Shows identification markers for result items 

Selection Status 
(page 105) 

Shows result item selection/highlight 

  

Result Columns 

The Results Table columns represent various types of information about each result item, 
including an item's attributes (actual and derived) and status. 

Click a column heading to sort the Results Table by that column. 

Drag a column heading to rearrange the table. 

See Column Manipulation (page 107) for other options. 
 

Chapter 7 

Work with Results 
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Hierarchy 

A result item may contain aggregate sub-items. For example, a PIBatch result item may 
contain multiple child PIUnitBatches, which, in turn, may contain multiple child 
PISubBatches. A single result item is able to show this hierarchy from itself down to the 
lowest level PISubBatch in the form of a tree. A result item cannot show its parent. 

 

A result item indicates that it has a child with a  or  symbol. To open a result item's tree 
and reveal its sub-items, click its  symbol. You can also open and close a selected item on 
the tree by pressing the left or right arrow key. Pressing the right arrow key opens a closed 
tree or selects the first child item of an open tree. Pressing the left arrow key closes an item's 
tree or selects a closed item's parent item. 

If a child item does not have data that is appropriate for all of the table's columns, the table 
shows the parent's data, which is grayed to indicate it is not a direct attribute of the item. 

For example, in the image above, the Chocolate2308_SLRY1.614 PIUnitBatch's Product is 
displayed in the Product column as "Chocolate Ice Cream". The child PISubBatches do not 
have product data and therefore show "Chocolate Ice Cream" as unavailable. 

 

Markers and Colors 

If the header of a result item is visible it may contain one of the following symbols: 

 

Each of these symbols can be any color. Their main purpose is for quick and easy 
identification. For example, the PI ProcessBook Batch Group symbol uses them to match a 
result item in the table with the bars of a Batch Gantt chart or the traces of a Batch Trend. 
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Select Items in the Results Table 

 

Click to select a result item, or use the Up and Down arrow keys. If the multiple-select 
feature is enabled, you can select multiple items by holding Ctrl or Shift while selecting. 
Multiple selection is useful for copying multiple items to the Clipboard (using Ctrl+C). You 
can also use multiple selection to change the Anchored and Visible state of multiple items; to 
do this, select multiple items and then change the Anchored or Visible state of one selected 
item. For example, if you select all of the items and then click  for one item, all of the 
selected items become hidden, regardless of their previous state. 

You can also select items by interacting with other parts of the application. For example, in a 
PI ProcessBook display, clicking a Batch Gantt bar selects the corresponding item in the 
Results Table. If the item you select is in a tree that is not visible, the tree opens to reveal that 
item. 

A highlighted item can sometimes be distracting. To clear a selection, click the blank space 
below the last item in the table, Ctrl+click the selected item, or click the row header of the 
selected item (if it is visible). 

 

Attribute Columns 

Most of the attribute columns in the Results Table represent actual attributes of PI SDK 
PIBatch, PIUnitBatch, or PISubBatch objects. Some of the columns in the table represent 
different things depending on the batch type. For example, the Batch ID column displays the 
Batch ID of a PIBatch or a PIUnitBatch, but displays a PISubBatch name because a 
PISubBatch is identified by its name rather than by a Batch ID. 

Column Type PIBatch PIUnitBatch PISubBatch 

Batch ID PIBatch Batch ID PIUnitBatch Batch ID PISubBatch Name 

Product PIBatch Product PIUnitBatch Product - 

Recipe Name PIBatch Recipe - - 

Unit Name - PIUnitBatch's Unit Name - 

Procedure - PIUnitBatch Procedure - 

Heading - PIUnitBatch's Unit Heading PISubBatch Heading 

Start Time PIBatch Start Time PIUnitBatch Start Time PISubBatch Start Time 

End Time PIBatch End Time PIUnitBatch End Time PISubBatch End Time 
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Column Type PIBatch PIUnitBatch PISubBatch 

Server PIBatch's PI Server PIUnitBatch's PI Server PISubBatch's PI Server 

Description - PIUnitBatch's Unit 
Description 

- 

Unique ID PIBatch Globally 
Unique Identifier 

PIUnitBatch Globally 
Unique Identifier 

PISubBatch Globally 
Unique Identifier 

For example, Recipe is a PIBatch property. Thus, a Recipe column shows the recipe name of 
the PIBatch in each result item row. Exceptions to this are: 

• Batch ID: Applies to PISubBatch items but shows the Name property. This is the 
PISubBatch's equivalent of Batch ID and, being in the same column, it assists in viewing 
the hierarchy relative to its parent PIUnitBatch. 

• Heading, Unit Name and Unit Description: Apply to PIUnitBatch items but are 
actually taken from the PIUnitBatch's PIUnit. 

Some attributes represent derived values of a batch. These attributes are: 

Column Type PIBatch PIUnitBatch PISubBatch 

Duration PIBatch Duration PISubBatch Duration PISubBatch Duration 

Batch Item Type PIBatch Item PIUnitBatch Item PISubBatch Item 

For example, Duration is not a direct property of any batch but can be calculated from the 
start and end times of any batch. 

Some columns are specific to a single batch type and others are common to two or more 
types. For example, the Recipe column applies only to PIBatch items, while both PIBatch 
and PIUnitBatch items share the Product column, and all batch types share the Start Time 
and End Time. 

 

Status Columns 

The status columns indicate the status of a result item. They are: 

Appearance State Behavior 

 Anchored (on) An Anchored item remains in the Results Table when a new 
search is run, regardless of the search parameters. This is 
useful, for example, if you want to use a batch as a template for 
comparison (that is, a "golden" or perfect batch). 

 (default) Unanchored 
(off) 

 (default) Visible The visibility state behavior varies depending on the application, 
but normally controls behavior outside of the Results Table. For 
example, in a PI ProcessBook display, when an item's state is 
Hidden, the corresponding item in the Batch Gantt chart and the 
Batch Trend is hidden. 

 Hidden (off) 
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Each status is relative only to the result item itself and not to the corresponding batch in the 
PI Batch Database. Click an item's status icon to change its status. 

If multiple-select is enabled and you select multiple items, changing the state of one of the 
selected items changes all selected items to that same state. 

 

Data Columns 

The types of data columns are: 

• Unit Property: displays a single PIProperty of each PIUnitBatch's Unit. This also applies 
to PIProperties of child modules of a PIUnitBatch's unit and to child PIProperties of 
PIProperties. PIBatch items in the table are blank and PISubBatch items show the same 
value as the parent PIUnitBatch item. 

• PIBatch Property: displays a single PIProperty of each PIBatch. This also applies to 
child PIProperties of PIProperties. PIUnitBatch and PISubBatch items in the table show 
the same value as the parent PIBatch item. 

• PI Tag: displays the interpolated value of a PI tag at the end time of each batch item. 
This applies to PIBatch, PIUnitBatch and PISubBatch items. If an item is still running, 
the value in this column is the tag's snapshot. 

• Alias: displays the interpolated value of a PIAlias' tag of each PIUnitBatch's unit at the 
end time of the PIUnitBatch. PIBatch items in the table are blank. PIUnitBatch items in 
the table shows data for the alias from the parent PIUnitBatch's unit; but it shows that 
value at the end of the PISubBatch If an item is still running, the value in this column is 
the tag's snapshot. 

• Expression: evaluates an expression over the period of each batch item and displays the 
result. This applies to PIBatch, PIUnitBatch and PISubBatch items, with one exception: 
If an expression contains aliases, PIBatch items are blank because aliases cannot be 
evaluated for a PIBatch. The range of the expression is typically the period of the batch 
item, but this depends on the expression syntax. 

For details on configuring data columns, see Column Attributes (page 112). 
 

Column Manipulation 

The columns in the Results Table are not fixed. You can remove, add, resize and reposition 
them. 

 

Add and Remove Columns 

You can add and remove column types in the Results Table. For details, see Configuring 
Results (page 110). 
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Resize Columns 

To resize a column, position the pointer on the right edge of the column header. When the 
pointer changes to a  (or similar), drag it to the left or right. To size a column to the width 
of its widest cell, double-click its right edge. 

You cannot resize the Anchored ( ) and Visible ( ) columns. 
 

Reposition Columns 

To move a column, drag its header to the left or right. A transparent image of the column 
header, which moves with the pointer, indicates which column you are moving, and a vertical 
line moves between columns to indicate where the column will sit when you release the 
mouse button. 

 

If you move a column to the leftmost position, it takes on the hierarchical tree format. This 
means that if you move the leftmost column, the next column becomes the leftmost and the 
tree format applies to that column. 

For example, if you move the Start Time column to the leftmost position, the hierarchy tree 
format applies as shown in the following figure. The Batch ID column (which is the leftmost 
column by default) does not show the tree view because it is no longer the leftmost column. 

 

Note: Moving a column does not affect the sort order, even if the column being moved is 
the primary sort column. 
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Sort 

You can sort items in the Results Table based on the data of any column or combination of 
columns. The sort order depends on the data type of the column being sorted. 

Column Data Type Sort Type 

Text Alphabetical 

Number Numerical 

Date Chronological 

Duration Numerical 

Status Locked/On/Off* 

*Unanchored and Hidden are considered "Off" statuses. 

The sorted column is indicated by an ascending ( ) or a descending ( ) triangle that is 
displayed in the column header. For example: 

 
 

Sort Multiple Columns 
Sometimes sorting a list of result items by a single column is not sufficient because the 
column may have multiple identical entries. When sorting multiple columns, sort the 
secondary columns before the primary column. For example, to sort items by Product, then 
by Start Time, first click the Start Time column header and then the Product column header. 
The result is: 

 

The Product column is sorted alphabetically with the "Chocolate Chip Ice Cream" and 
"Chocolate Ice Cream" items each sorted by Start Time. Also, only the primary sort column 
header (Product) contains the sort direction arrow ( ). 

You can use sort as many columns as are in the Results Table. 
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Configure Results 

The Configure Results feature—appearing in either a dialog box or area within a dialog 
box—configures the Results Table of the Batch Group in the display. Here you define which 
columns appear in the Results Table and set their properties. Settings include which columns 
appear, the column order, column width, and table sorting. 

 
 

Specify Columns 

You can add and remove columns in the Results Table by moving column types between the 
Column Types list and the Column Configurations list. Add columns in any of the 
following ways: 

• Select an item from the Column Types list and click Add. In the Column 
Configurations list, the column appears above the highlighted item. 

• Double-click the item you want to move. In the Column Configurations list, the column 
appears above the highlighted item. 

• Drag the column name from one list to the other. Use the insertion line that appears to 
drop the item where you want. 
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To remove an item from the Column Configurations list, select it and click Remove, or drag 
it to the Column Types list. 

 

Move Columns 

To move a column within the Column Configurations list, select it and click  or  in 
the top-right corner of the list, or drag it to a new position. 

 

To move a column in the sample Results Table at the bottom of the dialog box, drag the 
column to the new location. 

 

Size Columns 

You can size a column in the following ways: 

• In the Column Configurations list, click the Width value for the Column Type you 
want to change and enter the new width in screen pixels. 

• In the sample Results Table, position the pointer on the right edge of the column header. 
When the pointer changes to a , drag to resize the column. 
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Column Attributes 

Each item in the Column Configurations list represents a column and its attributes. For 
details on the column properties, see Column Attribute Settings (page 113). 

To edit a column's attributes, do one of the following: 

• Click the column for the item you want to change, edit the text, and press Enter or Tab 
(or press Esc to cancel the change). 

• Double-click the item you want to change. In the Column Attributes dialog box that 
appears, edit any of the attributes, and click OK. 

• Select the item you want to change and click Edit. In the Column Attributes dialog box 
that appears, edit any of the attributes, and click OK. 

 

Column Attributes Dialog Box 
Use the Column Attributes dialog box to enter the attributes of a column type. The Column 
Attributes dialog box that appears depends on the type of column—standard or data—that is 
being edited. 

 

Column Attributes dialog box for standard columns 

The Column Attributes dialog box for data columns includes the standard attributes, as well 
as an additional Source (page 114) area. Here you specify the source of the data for the 
column. 
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Column Attributes dialog box for data columns 

Depending on the column that is edited, some text boxes are grayed and cannot be edited 
(such as Column Type, Caption, Format, and Width for the Visible column), but you can 
select the text for copying to the Windows Clipboard. 

 

Column Attribute Settings 

Caption 
The caption of a Results Table column appears in its header. This does not apply to the 
Anchored and Visible columns, which do not have visible captions. 

 

Format 
A string representing the format for the data to take. For details on each of the format types, 
see Format Types (page 117). 

 

Width 
A column's width, measured in screen pixels. This does not apply to the Anchored and 
Visible columns, which have fixed widths. 

 

Sort 
The order in which to sort the column items. The options are None, Ascend, and Descend. 
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Sort Rank 
When you sort multiple columns, this box specifies the order in which to sort the columns. 

The Sort and Sort Rank attributes interact as follows: 

• The Sort Rank box is blank if the Sort value is All, since a column has no sort rank if it 
is not being sorted. 

• If the Sort value changes from None to Ascend or Descend, Sort Rank changes to 1. 

• If the Sort value changes from Ascend or Descend to None, Sort Rank changes to 
blank. 

• If the Sort Rank value changes from blank to a number, the Sort value changes to 
Ascend. 

• If the Sort Rank value changes from a number to blank, the Sort value changes to None. 
 

Source 
The Source area appears in Column Attributes for data columns only (Property, Aliases, 
Tag, and Expression columns). A column's source is a string that provides additional 
information about where data in the column is retrieved from. For example, a PI tag column's 
Source attribute contains the name of the PI tag to display in the column. 

The format of the Source area depends on column type. You can enter a column's source in 
the text box at the top of the Source area. 

In addition to the text box, each column type includes features to assist you in specifying the 
source. 

The Column Attributes dialog box for the Alias column includes an alias picker. You can 
select aliases common to all items in the Results Table or all aliases that are relative to the 
items in the Results Table. The picker contains aliases only if the Results Table that is being 
configured contains items; otherwise it is empty. When you select an alias in the picker, its 
source string appears in the text box. Similarly, if you enter an alias that matches one in the 
alias picker in the text box, the alias in the picker is selected. If you edit the text in the box, 
the selection clears until an alias is entered that matches one in the picker. 
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Note: If an alias is not in the picker, it is still accepted as an alias. No validation is done 
at this point. 

The Source areas of the PIBatch, PIProperty, and Unit PIProperty Column Attributes dialog 
boxes are similar to the Source area of the Column Attributes (Alias) dialog box, except 
that common—or all—PIProperties appear instead of aliases. 

The Column Attributes (PI Tag) dialog box's Source area contains only a Tag Search 
button, which opens the Tag Search dialog box. When you select a tag, the fully qualified tag 
name appears the text box. 

The Column Attributes (Expression) dialog box's Source area contains Tag Search, start 
time (ST), and end time (ET) buttons. When you select a tag from the Tag Search dialog 
box, the tag that appears in the text box is not fully qualified, but is simply the tag itself. The 
ST and ET buttons insert the start and end time placeholders ([S] and [E]). Thus, you don't 
need to remember the placeholders' formats to insert them. These buttons do not insert the 
single quote marks (') required for tags, aliases and time strings. 
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DATA TYPE SYNTAXES 

The data column types have the following syntaxes: 

Data Icon Syntax/Examples 

Unit 
PIProperty  

Syntax: 
[SubPIModule[\SubPIModule]||]PIProperty[|PIProperty] 

Examples: 
Manufacturer 
Sensors\Thermocouples||Count 
Inspection|Date 

PIBatch 
PIProperty  

Syntax: 
PIProperty[|PIProperty] 

Examples: 
Prop1 
Prop1|Prop2|Prop3 

PI tag  Syntax: 
[\\Server\]Tag 

Examples: 
Outside_Temp 
\\Localhost\Relative_Humidity 

Alias  Syntax: 
[Sub-PIModule[\Sub-PIModule]|]Alias 

Examples: 
Level 
Sensors\Temps|Temp1 

Expression 
 

Syntax: 
Standard PI PE expression syntax, with alias support and time placeholders. 
Examples: 
'cdt158' * 2 
TagAvg('temp', '[S]'+10m, '[E]') 

Aliases are used in expressions in the same way that PI tags are used: the name of the alias is 
used in the expression with single quote marks (') around it. Aliases are evaluated before the 
expression is evaluated; if an alias has the same name as a PI tag, the alias is used instead of 
the PI tag. Aliases of a PIModule that is a child of a PIUnitBatch's unit are also supported. 
The syntax follows that of the alias data column. 
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The time placeholders, [S] and [E], can be used anywhere a PI time is used. When the 
expression is evaluated, the placeholder is replaced with the batch item's actual start and end 
time. You can also use standard PI interval arithmetic with these placeholders. You must use 
the single quote marks (') of the PI PE expression syntax when using these placeholders. If * 
is used in an expression it is treated as the end time of the batch item, which is identical to 
using [E]. For example: 

TagAvg('Level', '[S]', '[E]') 
TagBad('Sensors\Temps|Temp1', '[S]+10m') 
TagMax('cdt158', '[E]-2h', '[E]') 

 

Format Types 
The following sections describe the format types you can use in the Format column of the 
Column Configurations list. 

 

Numeric Format 
Apply numeric formats to any column that contains numeric data. 

Characters Meaning Example 

0–000000 Number of significant digits/decimal places. Pad with 
leading/trailing zeros. 

0123.45600 

#-###### Number of decimal places. Do not pad with trailing zeros. 123.456 

. Decimal separator* 1.2 

, Thousands separator* 1,000,000 

* You must specify these separators regardless of your regional settings for them. The proper 
separators, however, appear in the Results Table per your regional settings. 

If numeric format characters are used for a cell that contains a date, the cell is formatted as 
the date format interprets the characters. 

 

Date Format 
The date format is the same format used by the PI SDK. The following table describes this 
format. See the PI SDK documentation for more details. 

Characters Meaning Example 

yy, yyyy Year. Two or four digits. 01, 2001 

M, MM Month. Short/long number. 3, 03 

MMM, MMMM Month. Short/long name. Mar, March 

d, dd Day. Short/long number. 2, 02 

ddd, dddd Weekday. Short/long name. Fri, Friday 

h, hh Hour. Short/long number. 4, 04 

m, mm Minute. Short/long number. 5, 05 
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Characters Meaning Example 

s, ss Seconds. Short/long number. 6,06 

0 - 00000 Fraction of a second. Show trailing zeros. 0.1 - 0.12300 

# - ###### Fraction of a second. No trailing zeros. 0.1 - 0.123 

z, zz Time zone. Short/long name. PDT, Pacific Daylight Time 

AP Local AM/PM symbol AM 

\ Next character is literal \h = "h" 

other char Itself x = "x" 

[blank] Windows Short Date format 03/02/2001 4:05 am 

If date format characters are used for a cell that contains numeric data, the cell is formatted as 
the numeric or duration formats interpret. 

 

Duration Format 
You can apply the duration format to any column that contains numeric data. The number is 
formatted as a duration instead of a number. In the following table, all examples use the same 
period of 0 years, 1 month, 3 days, 4 hours, 15 minutes and 43.6 seconds, beginning at 
1-Jan-04 00:00:00. 

Token Meaning Example Example Output 

 The length of the period in Years y-M-d 0-6-3 

M The length of the period in Months M, d 1, 3 

w The length of the period in Weeks w; d 4; 6 

d The length of the period in Days y, d 0, 34 

h The length of the period in Hours d, h:m:s 34, 4:15:44 

m The length of the period in Minutes d, h:m:s 34, 4:15:44 

s The length of the period in Seconds d:h:m:s 34:4:15:44 

i-iiiiii The minimum width of an interval, 
padded with zeros 

dddd,hh:mm:ss 0034,04:15:44 

[i] The short name for an interval d[d] 34d 

[ii] The long name for an interval, with 
automatic plurality 

d [dd] 34 days 

[iii] The singular long name for an interval 
(not common) 

m[m], d[ddd] 1mo, 85day 

[iiii] The plural long name for an interval (not 
common) 

m [mmmm],d[d] 1 months,85d 

{} Exclude everything within { } if all 
intervals are 0 

{y[y], }m [mm] 1 month 

. Fraction of an interval (up to 6 decimal 
places) 

d. 34.177499 
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Token Meaning Example Example Output 

0 Fraction of an interval, with trailing zeros h:m:s.000 820:15:43.600 

# Fraction of an interval, without trailing 
zeros 

h:m:s.### 820:15:43.6 

: Local time separator h:m:s 820:15:44 

\ Next character is literal a\\bc\de a\bcde 

P ISO 8601 period format P P0Y1M3DT4H15M44S 

PS ISO 8601 period + start time format PS 20040101T000000/ 
P0Y1M3DT4H15M44S 

PE ISO 8601 period + end time format {PE} P1M3DT4H15M44S/ 
20040203T041544 

PSE ISO 8601 start time + end time format PSE 20040101T000000/ 
20040203T041544 
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The PI Batch software (both PI BatchView and the PI Server components) have applicability 
across many industries. However, the terminology used in each industry varies. In some 
cases, generic batch terminology may be inadequate. 

The Custom Names feature allows you to customize batch-related terms that appear in the PI 
BatchView user interface (both at run time and build time). 

Custom names are organized in sets. Custom Name Sets are user-defined, and each set 
contains one or more custom names that apply to a single concept or theme. Every set has the 
same range of batch-related terms that you can customize. See Custom Names Terms (page 
147) for a list of customizable terms. Only terms within this range can be customized, but not 
all of them are required to be—see Example 1 (page 121). 

Note: Custom names apply only to specific batch-related client tools. They do not apply 
to the PI Server, PI SDK, or any of the COM interfaces for the PI BatchView 
objects. 

Following are three examples that show how you can use Custom Names. The examples are 
oversimplified, but they illustrate potential uses of Custom Names. 

 

Examples 

Example 1 

Company X is a traditional batch-oriented production company. Most of the batch terms used 
in PI BatchView apply to Company X's processes, but it would be helpful to change a few of 
the terms. For example, Company X would like to use Reactor instead of Unit. With Custom 
Names you can change the appearance of every instance of the term Unit and its counterparts 
so that they appear as Reactor. Such terms include Unit, Units, Unit Name, and Unit 
Heading. 

 
 

Chapter 8 

Use Custom Names 
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Example 2 

Company Y is a power generation company that does not do traditional batch processing. PI 
BatchView is still useful to the company because they monitor each turbine's startup process. 
Treating each startup as a PIUnitBatch allows them to compare them with previous startups. 
Traditional batch terms that appear in PI BatchView are not very helpful. With Custom 
Names they can rename several of their terms more appropriately. For example, they can use 
Still Starting in place of Still Running in the Results Table and Turbine in place of Unit Name 
in the Attributes search component. 

 

Example 3 

Organization Z runs an annual company-wide tennis tournament and uses PI BatchView to 
compare games, matches, and so on. Not only do they not want to see PI BatchView's 
standard batch terms, but also they use properties for things that have completely different 
meanings from the original batch term. For example, they store the name of the stadium 
hosting each set in the PIUnitBatch's Product field, but the word Product in the user-interface 
doesn't make much sense. Following is a view of QuickSearch with terms customized for a 
tennis tournament: 
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Use Custom Name Sets 

You can use Custom Name Sets in each of PI BatchView's client tools. You can configure 
QuickSearch for a single set. In PI ProcessBook, you can configure each BatchGroup symbol 
for its own set, and in Microsoft Excel, you can configure each formula array with its own 
set. 

 

Custom Name Set Box 

In PI BatchView QuickSearch, the Custom Name Set box is in the QuickSearch Options 
dialog box. In Microsoft Excel, it is in the Settings tab of the PI BatchView for Excel dialog 
box. In PI ProcessBook, it is in the Settings tab of the Batch Definition dialog box. The 
Custom Name Set box appears with the Restore Default button. 

 

The drop-down list displays a list of PI Servers in tree format. Initially, the server tree is 
collapsed. The server that contains the current set is also collapsed, but appears in bold text to 
indicate that it contains the current set. When a server is expanded, the tree shows a list of 
Custom Names sets defined on that server. 

 

Click a Custom Names set to select the set name and close the drop-down list. Clicking on a 
PI Server does not close the drop-down list. You can also manually edit the Custom Name 
Set box. The format of a Custom Names set name is: 

\\ServerName\CustomNameSetName 

If you do not specify the server, the default server is used. If PI BatchView cannot resolve the 
name (because it is not defined on the server or the server is offline), PI BatchView does not 
use any Custom Names set and it records a message in the message log. 

Note: When the Custom Names Sets feature is disabled, the Custom Name Set box is 
unavailable. To open the Custom Name Settings dialog box and enable Custom 
Names Sets, run the PIBatchCustomNameSettings.exe file in the 
\pipc\batch directory. 
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To revert the Custom Names set to the default set as defined in the Custom Names settings, 
click Restore Default. 

 

Custom Names Settings 

To view or change Custom Names settings for your computer, run the 
CustomNamesSettings.exe file located in the \PIPC\batch directory. 

Custom Names Settings apply to every application that uses Batch Custom Names sets, 
whether it is currently open or not. 

 
 

Enable Custom Names For This User 

The Custom Names feature is enabled by default on installation. Select this check box to 
disable or re-enable it. When this feature is disabled or enabled, all applications that are 
already open automatically change their user interface to the appropriate values. For example, 
disabling Custom Names immediately has the following effects: 

• Custom Names do not appear in the user interface of any application; the standard PI 
batch names are used instead.  

• The Custom Names Set drop-down list in every batch application is automatically 
disabled and grayed out. 
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Default Set For This Computer 

When you define a new PI BatchView function within a Microsoft Excel spreadsheet or 
insert a new BatchGroup symbol into a PI ProcessBook display, the default Custom Names 
set is applied. This Custom Names set is used throughout the definition dialogs for the new 
Microsoft Excel function or the new Batch Group symbol. 

Note: The default set affects only newly created items (such as in the PI BatchView 
add-in function for Microsoft Excel). It does not apply to dialog-based applications 
(such as PI BatchView QuickSearch) and other standalone applications. 

Changes made to the Default set for this computer appear for all users of the machine. If a 
user does not have permission to change this setting, the box is disabled and a warning 
message appears in the dialog box. 

 
 

Override the Default Set for This User 

You can change your own default Custom Name Sets without affecting other users. Check 
this box to enable the Custom Name Set box below it. When this box is checked, the Custom 
Names set shown in the box displays custom names for the current user only. 

If the current user does not have permission to change this setting, the check box and the 
drop-down list are unavailable and a read-only message appears in the dialog box. 

 

Create and Edit Custom Names Sets 

Each PI BatchView term to be renamed is defined within a Custom Names Set. A set is 
defined on a PI Server as a Module in the Module database (MDB). Thus, multiple sets can 
be defined on a single server. These definitions are defined using the PI BatchView Custom 
Naming plug-in for PI System Management Tools 3.0. The plug-in is distributed with PI 
System Management Tools versions 3.2 and greater. 

The online help distributed with the plug-in contains a full description of how to use it. A 
brief synopsis follows. 

The plug-in is located under the Batch branch of the plug-ins tree in the SMT3 host. When it 
loads, it shows the servers and their custom names in a tree on the left and the selected 
custom names set (no set initially), the customizable terms, and their descriptions on the right. 
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When you open a server in the tree, all of its custom names sets appear. When a custom 
names set is selected from the tree, the names are retrieved from the server and appear in the 
Custom Names Set panel. The left column shows the standard PI Batch name. The right 
column shows the corresponding custom name. Click a cell in the right column to enter a new 
custom name. 

The toolbar includes buttons to create new sets, save, delete sets, cut, copy and paste sets, and 
import and export sets. Buttons are also available above the Custom Names Set grid to group 
the names by category, or order them alphabetically by either the standard PI Batch name 
column or by the custom name column, and to toggle between views that show all terms and 
only those with custom names. 

Below the grid is a description pane that shows the original PI Batch term, its custom name, 
its category, and a description of what the name is and where it is used. 
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Part III 

Appendixes 





 

  
PI BatchView User Guide  129 

 

PI BatchView must be installed on a Microsoft Windows Operating System as specified in 
System Requirements (page 129). 

The installed PI BatchView package includes: 

• Batch Search (page 60) components 

• Results Table (page 61) 

• Batch Gantt Chart (page 63) 

• Batch Trend (page 74) 

• Microsoft Excel add-in (page 13) 

• PI BatchView QuickSearch (page 7) utility 

• Help files 

To take full advantage of PI BatchView, first install PI ProcessBook, Microsoft Excel, and PI 
DataLink. 

The PI BatchView installation method that is supported by OSIsoft is to use the distributed 
setup kit. Administrative privileges are required while installing. 

 

System Requirements 

The full PI BatchView installation package requires: 

• Microsoft Windows 2000, Windows XP, or Windows 2003 server 

• Microsoft Excel XP (2002) or higher, for the Microsoft Excel add-in 

• PI ProcessBook 3.0.15 or higher, for the PI ProcessBook components 

• PI Server version 3.3 SR1 (3.3.361.98) or higher 

To view existing batch data stored in the Batch Subsystem in PI BatchView 3.0 and later, you 
must first create copies of the units from the pibaunit table and place these into the 
Module Database. For details, see Batch Database Support of the PI Batch Subsystem found 
on the OSIsoft Technical Support Web site. 
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Setup Kit 

PI BatchView is distributed as a self-extracting executable. Before running this executable, 
close all other programs so that they do not interfere with the installation process. 

The executable opens a message box stating that it will install PI BatchView. Then it opens 
the WinZip Self-Extractor dialog box. 

 

The recommended options, Overwrite files without prompting and When done unzipping 
open: setup.exe, are checked by default. 

Click Unzip to unzip and run the setup kit. If When done unzipping open: setup.exe is not 
checked, you must run the setup.exe file from the unzip folder path specified in the 
Unzip to folder box. 

 

Setup Wizard 

This welcome screen lists the dependant components that will be installed. Setup only installs 
components that are not installed or that need to be updated. 
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If a compatible version of PI ProcessBook is not installed, a warning screen appears. See 
System Requirements (page 129) for details on PI ProcessBook version requirements. 

Note: If you install PI BatchView before upgrading PI ProcessBook, then later upgrade 
PI ProcessBook, you must re-install PI BatchView. 

After installing the prerequisite components, Setup displays two screens that may require 
your input for destination and PI Server information. 

If another OSIsoft product is installed, you cannot change the destination folder or PI Server 
information—PI BatchView is installed in the PIPC folder and a default PI Server and user 
name is specified. Usually, this information is already determined in the installation of PI 
ProcessBook or another PI client application. 

Follow the instructions on the remaining Setup screens to complete the installation. 
 

Post-Setup Steps 

The results of the setup wizard are available in the setup log files, 
SetupBatchView_Setup.log and BatchViewMaster.log, located in the 
PIPC\Dat folder. OSIsoft Technical Support requires these files to assist with any problems 
that occur during installation. 

The PI BatchView add-in for Microsoft Excel loads into Microsoft Excel after the PI 
BatchView installation is complete. The Microsoft Excel Add-Ins dialog box includes PI 
BatchView for Microsoft Excel and PIBVExcel.Functions. Once the add-ins are loaded for 
the first time, HKEY_CURRENT_USER\Software\PISystem\PI-
BatchView\Excel\Installed =1 is written to the registry. When this key is 1, PI BatchView 
for Excel does not automatically load the add-ins on startup. This allows you to unload PI 
BatchView for Excel through the Microsoft Excel Add-Ins dialog while keeping PI 
BatchView installed.  

An older Microsoft Excel add-in is also installed: version 2.1.1.2 of pibat32.xla. This 
add-in is necessary for backward compatibility with worksheets created from PI BatchView 
versions 3.0 and earlier. If you need this add-in, you must manually configure it in Microsoft 
Excel. To do this: in Microsoft Excel, choose Tools > Add-Ins. In the dialog box that 
appears, click Browse, navigate to the PIPC\Batch folder, and select pibat32.xla. 

You can run both the current and 2.1.1.2 version of the add-in side-by-side. 
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To verify setup, browse to the PIPC\Batch folder (typically at C:\Program 
Files\PIPC\Batch). The release notes (PIPC\Batch\readme.htm) list the files 
that are installed with PI BatchView. You can also check from the Windows Start menu > 
Programs > PI System > PI BatchView QuickSearch. 

 

Uninstalling and Repairing PI BatchView 

We recommend using administrative privileges while repairing or uninstalling PI BatchView. 

To repair or uninstall PI BatchView: 

1. Open the Windows Control panel and choose Add or Remove Programs. The Add or 
Remove Programs dialog box that appears contains a list of installed applications. 

2. Depending on your Windows version, select Change/Remove or Add/Remove. PI 
BatchView Setup runs with Application Maintenance dialog box. 

3. If you select Repair, the program searches for missing components or corrupt registry 
keys attempts to restore them. This process is much quicker than the installation process 
because not every component needs to be restored. 

If you select Remove, a warning appears and the program uninstalls PI BatchView. It 
leaves any files that do not belong to PI BatchView in the PIPC\Batch folder. It does 
not remove any shortcuts or copies of PI BatchView components that are not in the 
original places they were installed. 
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Upgrading from PI BatchView 2.1 is designed to be as seamless as possible. Because of the 
advances in storing batches on the PI Server, however, behaviors have changed. 

If you are upgrading from version 3.0, skip to Microsoft Excel Add-In (page 134). 
 

View Batch Subsystem Batches 

To view existing batch data stored in the Batch Subsystem in PI BatchView 3.0 and later, you 
must first create copies of the units from the pibaunit table and place these into the 
Module Database. For details, see Batch Database Support of the PI Batch Subsystem found 
on the OSIsoft Technical Support Web site. 

 

ActiveX Controls for Searching Batches 

The search controls for PI BatchView 3.0 and later have been completely redesigned since 
version 2.1. Any code written for the version 2.1 ActiveX control (pibatchv.ocx) does 
not work with the newer controls. However, the 2.1 version of the control still ships with the 
current version of PI BatchView for backward compatibility of your existing projects. 

The 2.1 ActiveX control uses the PI API, which supports batches from the Batch Subsystem 
(BSS) and PIUnitBatches from the Batch Database (BDB). On the other hand, the current PI 
BatchView Search controls and add-in for PI ProcessBook use the PI SDK, which supports 
the full batch hierarchy from the BDB but requires a copy of the unit in the Module Database 
to view BSS batches as PIUnitBatches. See Viewing Batch Subsystem Batches (page 133) for 
details. 

 

Batch Trend Conversion 

The current version of PI BatchView supports displays created with PI BatchView 2.1. 

When you open a display containing a Batch Trend created with BatchView 2.1, the display 
treats the Batch Trend as a Batch Group with only a Batch Trend showing. If you do not edit 
the Batch Trend, you can save the display without changing its format to a Batch Group; it 
remains a version 2.1 Batch Trend. 

In Build mode, when you double-click a version 2.1 Batch Trend in the display, the Batch 
Definition dialog box for the current version of BatchView appears. If there are any edits that 
invoke a feature introduced in BatchView 3.0 or later, a dialog box appears asking if you 

Appendix B 
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want to convert your 2.1 Batch Trend to a Batch Group. Converting a Batch Trend to a Batch 
Group is not reversible. 

Some existing PI ProcessBook displays may not work properly until you create the PIUnit in 
the Batch Database (BDB) corresponding to the Batch Subsystem (BSS) unit. This includes: 

• Searches for batches from the BSS 

• Any PI ProcessBook displays that search for batches with the 2.1 ActiveX control and 
then populate the Batch Trend with the resulting batches 

 

Color Schemes 

For easier identification of batch data across the Gantt chart, Results Table, and Batch Trend, 
color schemes have changed. A PI ProcessBook display with a Batch Trend symbol that was 
created with BatchView 2.1 opens with the same color scheme as in 2.1. Until a new feature 
specific to BatchView 3.0 or later is chosen, the old color scheme is supported for that Batch 
Trend symbol. 

If you attempt to add a Search, Results Table, Gantt Chart, or additional Batch Trend symbol 
in the Batch Definition Layout tab, a warning message appears: 

 

Click Cancel to prevent the change from taking place. Click OK to apply the new color 
scheme. 

 

Programmatic Interface 

The Batch Trend's automation interface from PI BatchView 2.1 is supported in the current 
release with a few exceptions. Refer to the release notes (readme.htm in the 
\PIPC\batch directory) for the latest information. 

 

Microsoft Excel Add-In 

PI BatchView 3.1 introduces a redesigned Microsoft Excel add-in implementing full PI Batch 
Database implementation. However, for compatibility, PI BatchView ships with version 
2.1.1.2 of the Microsoft Excel add-in. This version fully supports all Microsoft Excel 
worksheets created with PI BatchView 2.1. You can use the 3.1 and 2.1.1.2 add-ins side-by-
side in Microsoft Excel. See Post-Setup Steps (page 131) for details on how to do this. 
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Version 2.1.1.2 is based on the PI API. Thus it can detect Batch Subsystem (BSS) batches 
and PIUnitBatches from the PI Batch Database (BDB). However, it cannot detect PIBatches 
or PISubBatches from the BDB. 

Version 3.0 is based on the PI SDK and can fully access PI Batch Database batch items such 
PIBatches, PIUnitBatches, and PISubBatches. 
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The PI BatchView Microsoft Excel add-in installs several functions into Microsoft Excel. 
The main function is PIBVSearch. There are also several supporting functions, which are 
discussed in Optional Arguments (page 140). When you choose PI > Batch Search… the 
PIBVSearch function is pasted into your spreadsheet as required by the function. In most 
cases you do not need to modify it. 

To access these functions in Microsoft Excel, choose Insert > Function. In the Insert 
Function dialog box that appears, select PIBVExcel.Functions from the drop-down list. 

 
 

PIBVSearch 

Syntax 

=PIBVSearch(BatchSearchType, PIServers, SelectType, Count, 
IncludeState, TimeState, SearchStartTime, SearchEndTime, 
CustomNameSet, Headers, DisplayOptions, OptionalArguments) 

 

Appendix C 
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Parameters 

Argument Description 

BatchSearchType A numeric expression that specifies the type of batch search to do. The 
options are: 
1: PIBatch Search 
2: PIUnitBatch Search 
This parameter has no default, a value must be specified. 

PIServers A string expression or cell reference that specifies the PI Server(s). If more 
then one PI Server is specified, each server must be separated by a comma. 
If an empty string ("") or nothing at all is specified, the default server is used. 

SelectType A numeric expression or cell reference that specifies which records to find. 
The options are: 
0: All Batches 
1: First XX Batches 
2: Last XX Batches 
Where XX is the value specified in the Count argument. 
If nothing is specified, the default of 0 (All Batches) is used. 

Count A numeric expression or a cell reference that specifies the number of 
Batches to return. Only used when applicable. 
If nothing is specified, the default of 1 is used. 

IncludeState A numeric expression or cell reference that specifies the state of the batches 
to include. The options are: 
1: Running Batches 
2: Completed Batches 
3: Both Running and Completed Batches 
If nothing is specified, the default of 3 (Both) is used. 

TimeState A numeric expression or cell reference that specifies the state of the batch in 
the time range searched in. The options are: 
0: Batches that have started in the time range. 
1: Batches that are active in the time range. 
2: Batches that fit entirely in the time range. 
3: Batches that have ended in the time range. 
If nothing is specified, the default of 1 (Active) is used. 

SearchStartTime A string expression or cell reference that specifies the time range component 
of the beginning boundary of the search. 
If nothing is specified, the default of *-1 day is used. 

SearchEndTime A string expression or cell reference that specifies the time range component 
of the ending boundary of the search 
If nothing is specified, the default of * is used. 

CustomNameSet A string expression or cell reference that specifies the Custom Name Set to 
use. The format of a custom name set is: 
     \\PIServerName\CustomNameSet 
If nothing is specified, the standard Custom Name set is used. 

Headers A string expression or cell reference that specifies the ordering of the data 
returned. See Headers (page 139). 
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Argument Description 

DisplayOptions A numeric expression or cell reference that specifies the display options in 
Microsoft Excel. See Display Options (page 140). 

OptionalArguments Optional Arguments describing PI Batch, PI Unit Batch, and PI Sub Batch 
search masks, durations, and filtering. See Optional Arguments (page 140). 

  

Headers 
The headers parameter specifies which properties to display. The list of headers used is a 
comma-separated list with the following parts: 

• A one-character string specifying which header to use. Valid string values are: 
Value Description Value Description 

B Batch ID D Duration 

S Start Time H PIUnit Heading 

E End Time A PISubBatch Heading 

P Product T Description 

U Unit I Unique ID 

C Procedure Y Batch Item Type 

V Server O PIBatch PIProperty 

R Recipe  

• A sign to specify the sort direction. Valid sort direction indicator values are: 
Value Description 

+ Ascending 

- Descending 

. No Sorting 

• A number to specify the sort index 

• An optional header title to override the default header title. Any string can be used. The 
header title must be preceded by the pipe character (|). 

• The PIBatch PIProperty path (applies only to PIBatch PIProperty columns) 

The following example shows the Batch ID, Start Time, and End Time, sorted by Start Time 
in ascending order, with the Batch ID title overwritten with Lot #: 

"B.0|Lot #,S+1,E.0" 

For a PIBatch PIProperty header, the path to the PIProperty in the PIBatch is required. To 
specify this, add another pipe character, then the path to the PIProperty, which may include 
more pipe characters. Since the title is not required, it is possible to have two pipe characters 
with nothing between them. For example: 

"B.0|Lot #,S+1,E.0,O.0||PIProperties|PISubProperties|PIProperty" 
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Display Options 
The display options control how the search output is displayed. The value of this parameter is 
a bit mask. To specify options, use the sum of the values for all the options you want. 

The options are: 

Value Description 

0-7 Number of Levels to show. 0 means show only the Level searched for (that is, just Unit 
Batches when doing a PIUnitBatch search). Higher values show the children (that is, the 
sub-batches from a unit batch or sub-batch) 

8 Display the number of PIBatches or PIUnitBatches returned. If not specified, then do not 
display the count. 

16 If number of Levels to show is greater then 0, then indent children batches into the next 
cell, and use the type of batch as the header if headers are shown. If not specified, then 
do not indent into the next cell. 

32 If number of Levels to show is greater then 0, then indent children batches using cell 
indenting. If not specified, then do not use cell indenting. 

64 If number of levels to show is greater then 0, then use Microsoft Excel grouping. If not 
specified, then grouping is not used. 

128 Display the header titles for the data shown. If not specified, then headers are not 
shown. 

256 Orient data in columns. If not specified, then data is oriented in rows 
  

Optional Arguments 
The optional arguments describe the search masks, duration lengths, and filtering for PIBatch, 
PIUnitBatch, and PISubBatches. The arguments are themselves functions, which provide a 
way to reference cells for their values, and to make it easier to read. 

The functions that can be used as optional arguments are: PIBVBatchSearchMasks, 
PIBVUnitBatchSearchMasks, PIBVSubBatchSearchMasks, PIBVBatchDuration, 
PIBVUnitBatchDuration, PIBVSubBatchDuration, PIBVBatchFilter, PIBVUnitBatchFilter, 
and PIBVSubBatchFilter. 

 

Returns 

The query results appear in a rectangular array, arranged according to the Display Options. 
 

Remarks 

Paste this function into your worksheet as a rectangular array by pressing Ctrl+Shift+Enter. 
The horizontal or vertical dimension of the array (according to the Display Options setting) 
must cover the same number of cells as the number of headers in the Headers argument. Its 
other dimension must cover enough cells to contain the number of results that you expect the 
query to return. 
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PIBVBatchSearchMasks 

Use this function only as an optional argument in the PIBVSearch function. 
 

Syntax 

PIBVBatchSearchMasks(Batch ID, Product, Recipe) 
 

Parameters 

Part Description 

Batch 
ID 

A string expression or cell reference that specifies a PIBatch Batch ID. 
If nothing is passed, the default of * is used. 

Product A string expression or cell reference that specifies a PIBatch Product. 
If nothing is passed, the default of * is used. 

Recipe A string expression or cell reference that specifies a PIBatch Recipe. 
If nothing is passed, the default of * is used. 

  

Returns 

This function returns the passed-in arguments separated by pipe characters (|) with the prefix 
BM. 

 

Remarks 

This function returns a string, not an array. 
 

PIBVUnitBatchSearchMasks 

Use this function only as an optional argument in the PIBVSearch function. 
 

Syntax 

PIBVUnitBatchSearchMasks(Batch ID, Product, UnitName, 
UnitHeading, Procedure) 

 

Parameters 

Part Description 

Batch ID A string expression or cell reference that specifies a PIUnitBatch Batch ID. 
If nothing is passed, the default of * is used. 
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Part Description 

Product A string expression or cell reference that specifies a PIUnitBatch Product. 
If nothing is passed, the default of * is used. 

UnitName A string expression or cell reference that specifies a PIUnitBatch UnitName. The 
format for this option is specified in the Attributes Component of Chapter 2., 
Searching for Batches. 
If nothing is passed, the default of * is used. 

UnitHeading A string expression or cell reference that specifies a PIUnitBatch UnitHeading. 
If nothing is passed, the default of * is used. 

Procedure A string expression or cell reference that specifies a PIUnitBatch Procedure. 
If nothing is passed, the default of * is used. 

  

Returns 

This function returns the passed in arguments separated by pipe characters (|) with the prefix 
UBM. 

 

Remarks 

This function returns a string, not an array. 
 

PIBVSubBatchSearchMasks 

Use this function only as an optional argument in the PIBVSearch function. 
 

Syntax 

PIBVSubBatchSearchMasks(Name, Heading) 
 

Parameters 

Part Description 

Name A string expression or cell reference that specifies a PISubBatch Name. 
If nothing is passed, the default of * is used. 

Heading A string expression or cell reference that specifies a PISubBatch Heading. 
If nothing is passed, the default of * is used. 

  

Returns 

This function returns the passed in arguments separated by pipe characters (|) with the prefix 
SBM. 
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Remarks 

This function returns a string, not an array. 
 

PIBVxxxDuration 

This function description applies to PIBVBatchDuration, PIBVUnitBatchDuration, and 
PIBVSubBatchDuraiton. 

Use these functions only as optional arguments in the PIBVSearch function. 
 

Syntax 

PIBVxxxDuration(DurationType, DurationLength1, DurationLengh2) 
 

Parameters 

Part Description 

DurationState A numeric expression or cell reference that specifies the duration type of the 
duration lengths specified. Possible values are: 
0: Any Length 
1: Shorter Than 
2: Between 
3: Longer Than 
If Any Length is specified, DurationLength1 and DurationLength2 are ignored. 
If nothing is specified, the default of 0 (Any Length) is used. 

DurationLength1 A string expression or cell reference that specifies the duration length of a 
batch. This field is used only when DurationState is 1 (shorter than), 2 
(between), or 3 (longer than). 
If nothing is passed, the default of 1 hour is used. 

DurationLength2 A string expression or cell reference that specifies the duration length of a 
batch. This field is used only when DurationState is 2 (between). 
If nothing is passed, the default of 1 minute is used. 

  

Returns 

These functions return the passed-in arguments separated by pipe characters (|) with the 
prefix BD (BatchDuration), UBD (UnitBatchDuration), or SBD (SubBatchDuration). 

 

Remarks 

These functions return a string, not an array. 
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PIBVxxxFilter Functions 

This function description applies to PIBVBatchFilter, PIBVUnitBatchFilter, and 
PIBVSubBatchFilter. 

Use these functions only as optional arguments in the PIBVSearch function. 
 

Syntax 

PIBVxxxFilter(Filter, FilterPeriodType, FilterPeriodLength1, 
FilterPeriodLength2) 

 

Parameters 

Part Description 

Filter A numeric expression or cell reference that specifies the filter string used to 
verify that a value is true. 
If nothing is specified, the default of blank is used. 

FilterPeriodType A numeric expression or cell reference that specifies the filter period type of 
the filter lengths specified. The options are: 
0: Any Time 
1: Less Than 
2: Between 
3: Greater Than 
4: Always 
5: Absolute 
If Any Time or Always is specified, FilterPeriodLength1 and 
FilterPeriodLength2 are ignored. 
If nothing is specified, the default of 0 (Any Time) is used. 

FilterPeriodLength1 A string expression or cell reference that specifies the filter period length that 
the filter must be true for. This field is only used when the FilterPeriodType 
value is 1 (less than), 2 (between), or 3 (greater than). 
If nothing is passed, the default of 1% is used. 

FilterPeriodLength2 A string expression or cell reference that specifies the filter period length that 
the filter must be true for. This field is only used when the FilterPeriodType 
value is 3 (between). 
If nothing is passed, the default of 99% is used. 

  

Returns 

These functions return the passed-in arguments separated by pipe characters (|) with the 
prefix BF (BatchFilter), UBF (UnitBatchFilter), or SBF (SubBatchFilter). 

 

Remarks 

These functions return a string, not an array. 



 PIBVxxxFilter Functions 

  
PI BatchView User Guide  145 
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Many—but not all—of the terms that appear in PI BatchView can be renamed. Custom 
naming does not affect the way the data appears, only the terms that are part of the user 
interface. This appendix lists all the terms that can be renamed. 

 

General 

These terms include the titles and captions of dialog boxes and controls. The captions of 
search parameter components are not necessarily visible. So although the caption may be 
renamed, it may not appear in the component. Furthermore, the default caption (and the 
renamed caption) of these components can be overridden by the host application-therefore, 
the renaming may not take effect. 

Term Description 

Attributes Caption The default caption of the Attributes search parameter component. 

Duration Caption The default caption of the Duration search parameter component and the 
default label of the Duration column header in the Results Table. 

Filter Caption The default caption of the Filter search parameter component. 

Select Caption The default caption of the Select search parameter component. 

Time Range Caption The default caption of the Time Range search component. 

Unit The term for a PIUnit used in the Unit Mask Selection dialog box. 

Units The plural of the term for a PIUnit used in the Unit Mask Selection dialog 
box. 

  

Appendix D 

Custom Names Terms 
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PIBatch Terms 

Name Description 

Batch ID The Batch ID attribute of a PIBatch displayed in the Attributes parameter 
component and the default caption of the Batch ID column header in the 
Results Table (PIBatch Result items). 

PIBatch The term for a PIBatch in the Batch Type column of the Results Table. 

PIBatches The term for the plural of PIBatch that indicates the batch type in the 
Select parameter component. 

Product The Product attribute of a PIBatch displayed in the Attributes parameter 
component and the default caption of the Product column header in the 
Results Table (PIBatch Result items). 

Recipe The Recipe attribute of a PIBatch displayed in the Attributes parameter 
component and the default caption of the Recipe column header in the 
Results Table. 

Still Running The end-time text in the Results Table that indicates that a PIBatch that 
has not yet completed. 

  

PIUnitBatch Terms 

Term Description 

Batch ID The Batch ID attribute of a PIUnitBatch displayed in the Attributes 
parameter component and the default caption of the Batch ID column 
header in the Results Table (PIUnitBatch Result items). 

PIUnitBatch The term for a PIUnitBatch in the Batch Type column of the Results 
Table. 

PIUnitBatches The term for the plural of PIUnitBatch that indicates the batch type in the 
Select parameter component. 

Procedure The Procedure attribute of a PIUnitBatch displayed in the Attributes 
parameter component and the default caption of the Procedure column 
header in the Results Table. 

Product The Product attribute of a PIUnitBatch displayed in the Attributes 
parameter component and the default caption of the Product column 
header in the Results Table (PIUnitBatch Result items). 

Still Running The end-time text in the Results Table that indicates that a PIUnitBatch 
that has not yet completed. 

Unit Heading The Unit Heading attribute of a PIUnitBatch displayed in the Attributes 
parameter component and the default caption of the Unit Heading 
column header in the Results Table. 

Unit Name The Unit Name attribute of a PIUnitBatch displayed in the Attributes 
parameter component and the default caption of the Unit Name column 
header in the Results Table. 
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PISubBatch Terms 

Term Description 

Heading The Heading attribute of a PISubBatch displayed in the Attributes 
parameter component and the default caption of the PISubBatch 
Heading column header in the Results Table. 

Name The Name attribute of a PISubBatch displayed in the Attributes 
parameter component. 

PISubBatch The term for a PISubBatch in the Batch Type column of the Results 
Table. 

PISubBatches The term for the plural of PISubBatch in the Batch Type column of the 
Results Table. 

Still Running The end-time text in the Results Table that indicates that a PISubBatch 
that has not yet completed. 

  

Search Parameter Terms 

Term Description 

Active The activity state of the Time Range component that specifies items that 
are running at some point within the time range. 

Both The Select component option to specify items that both have and have 
not completed (PIBatch selection mode). 

Both The Select component option to specify items that both have and have 
not completed (PIUnitBatch selection mode). 

Completed The Select component option to specify only items that have completed 
(PIBatch selection mode). 

Completed The Select component option to specify only items that have completed 
(PIUnitBatch selection mode). 

Ended The activity state of the Time Range component that specifies items that 
end within the time range. 

Entirely The activity state of the Time Range component that specifies items that 
start and end within the time range. 

Running The Select component option to specify items that have not completed 
(PIBatch selection mode). 

Running The Select component option to specify items that have not completed 
(PIUnitBatch selection mode). 

Started The activity state of the Time Range component that specifies items that 
start within the time range. 
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Results Table Columns 

The host application or the user can override the default caption and the renamed caption of the Results 
Table columns, and therefore the renaming may have no effect. Many columns that are available in the 
Results Table are not present in this section because they are present in other sections. For example, 
Batch ID is already included in both the PIBatch (page 148) and PIUnitBatch (page 148) sections. 

The default labels for the column headers in the results table are: 

• Alias 

• Batch Item Type 

• Batch Property 

• End Time 

• Expression 

• Start Time 

• Tag 

• Unique ID 

• Unit Description 

• Unit Property 
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You can read complete information about technical support options, and access all of the 
following resources at the OSIsoft Technical Support Web site: 

http://techsupport.osisoft.com (http://techsupport.osisoft.com) 

Before You Call or Write for Help 

When you contact OSIsoft Technical Support, please provide: 

• Product name, version, and/or build numbers 

• Computer platform (CPU type, operating system, and version number) 

• The time that the difficulty started 

• The message log(s) at that time 

Help Desk and Telephone Support 

You can contact OSIsoft Technical Support 24 hours a day. Use the numbers in the table 
below to find the most appropriate number for your area.  Dialing any of these numbers will 
route your call into our global support queue to be answered by engineers stationed around 
the world. 

Office Location Access Number Local Language Options 

San Leandro, CA, USA 1 510 297 5828 English 

Philadelphia, PA, USA 1 215 606 0705 English 

Johnson City, TN, USA 1 423 610 3800 English 

Montreal, QC, Canada 1 514 493 0663 English, French 

São Paulo, Brazil 55 11 3053 5040 English, Portuguese 

Altenstadt, Germany 49 6047 9890 English, German 

Manama, Bahrain 973 1758 4429 English, Arabic 

Singapore 65 6391 1811 English, Mandarin 

Perth, WA, Australia 61 8 9282 9220 English 

Support may be provided in languages other than English in certain centers (listed above) 
based on availability of attendants. If you select a local language option, we will make best 
efforts to connect you with an available Technical Support Engineer (TSE) with that language 
skill. If no local language TSE is available to assist you, you will be routed to the first 
available attendant. 

Appendix E 

Technical Support and Resources 

http://techsupport.osisoft.com/�
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If all available TSEs are busy assisting other customers when you call, you will be prompted 
to remain on the line to wait for the next available TSE or else leave a voicemail message.  If 
you choose to leave a message, you will not lose your place in the queue.  Your voicemail 
will be treated as a regular phone call and will be directed to the first TSE who 
becomes available. 

If you are calling about an ongoing case, be sure to reference your case number when you call 
so we can connect you to the engineer currently assigned to your case.  If that engineer is not 
available, another engineer will attempt to assist you.  

Search Support 

From the OSIsoft Technical Support Web site, click Search Support. 

Quickly and easily search the OSIsoft Technical Support Web site's Support Solutions, 
Documentation, and Support Bulletins using the advanced MS SharePoint search engine. 

Email-based Technical Support 

techsupport@osisoft.com 

When contacting OSIsoft Technical Support by email, it is helpful to send the following 
information:  

• Description of issue: Short description of issue, symptoms, informational or error 
messages, history of issue  

• Message logs: See documentation for your PI System for information on obtaining 
message logs pertinent to the situation. 

Online Technical Support 

From the OSIsoft Technical Support Web site, click Contact us > My Support > My Calls. 

Using OSIsoft's Online Technical Support, you can:  

• Enter a new call directly into OSIsoft's database (monitored 24 hours a day)  

• View or edit existing OSIsoft calls that you entered  

• View any of the calls entered by your organization or site, if enabled  

• See your licensed software and dates of your Service Reliance Program agreements  

Remote Access  

From the OSIsoft Technical Support Web site, click Contact Us > Remote Support 
Options. 

OSIsoft Support Engineers may remotely access your server in order to provide hands-on 
troubleshooting and assistance. See the Remote Access page for details on the various 
methods you can use.  
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On-site service  

From the OSIsoft Technical Support Web site, click Contact Us > On-site Field Service 
Visit. 

OSIsoft provides on-site service for a fee. Visit our On-site Field Service Visit page for more 
information. 

Knowledge Center 

From the OSIsoft Technical Support Web site, click Knowledge Center. 

The Knowledge Center provides a searchable library of documentation and technical data, as 
well as a special collection of resources for system managers. For these options, click 
Knowledge Center on the Technical Support Web site. 

• The Search feature allows you to search Support Solutions, Bulletins, Support Pages, 
Known Issues, Enhancements, and Documentation (including user manuals, release 
notes, and white papers). 

• System Manager Resources include tools and instructions that help you manage: Archive 
sizing, backup scripts, daily health checks, daylight savings time configuration, PI Server 
security, PI System sizing and configuration, PI trusts for interface nodes, and more. 

Upgrades 

From the OSIsoft Technical Support Web site, click Contact Us > Obtaining Upgrades. 

You are eligible to download or order any available version of a product for which you have 
an active Service Reliance Program (SRP), formerly known as Tech Support Agreement 
(TSA). To verify or change your SRP status, contact your Sales Representative or Technical 
Support (http://techsupport.osisoft.com/) for assistance. 

 

http://techsupport.osisoft.com/�
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